Setup Guide

Versio™ v2.0.4

8-April-2014

Revision: Release
Publication Information

© 2014 Imagine Communications Corp.       Proprietary and Confidential.

Imagine Communications considers this document and its contents to be proprietary and confidential. Except for making a reasonable number of copies for your own internal use, you may not reproduce this publication, or any part thereof, in any form, by any method, for any purpose, or in any language other than English without the written consent of Imagine Communications. All others uses are illegal.

This publication is designed to assist in the use of the product as it exists on the date of publication of this manual, and may not reflect the product at the current time or an unknown time in the future. This publication does not in any way warrant description accuracy or guarantee the use for the product to which it refers. Imagine Communications reserves the right, without notice to make such changes in equipment, design, specifications, components, or documentation as progress may warrant to improve the performance of the product.

Trademarks

Product names and other brands (such as ADC™, D-Series™, Nexio®, Nexio® Insight, Nexio® Motion, PowerSmart®, Versio™) are trademarks or trade names of Imagine Communications or its subsidiaries. Microsoft® and Windows® are registered trademarks of Microsoft Corporation. All other trademarks and trade names are the property of their respective companies.

Contact Information

Imagine Communications has office locations around the world. For domestic and international location and contact information see: http://www.imaginecommunications.com/contact-us/

Support Contact Information

For domestic and international support contact information see:

- Support Contacts: http://www.imaginecommunications.com/services/technical-support/
- eCustomer Portal: http://support.imaginecommunications.com
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Applied Configuration</td>
<td>21</td>
</tr>
<tr>
<td>Pulled Configurations</td>
<td>21</td>
</tr>
<tr>
<td>Edit and Save Plug-in Settings</td>
<td>21</td>
</tr>
<tr>
<td>Edit Plug-in Settings</td>
<td>21</td>
</tr>
<tr>
<td>View Plug-in Revisions</td>
<td>22</td>
</tr>
<tr>
<td>Use Plug-in Presets</td>
<td>22</td>
</tr>
<tr>
<td>Use Configuration Presets</td>
<td>22</td>
</tr>
<tr>
<td>Manage Configurations</td>
<td>23</td>
</tr>
<tr>
<td>Load a Configuration</td>
<td>23</td>
</tr>
<tr>
<td>Push a Configuration to the Versio System</td>
<td>23</td>
</tr>
<tr>
<td>Load the Last Applied Configuration</td>
<td>24</td>
</tr>
<tr>
<td>Check the Device State</td>
<td>24</td>
</tr>
<tr>
<td>View Previous Configuration Versions</td>
<td>24</td>
</tr>
<tr>
<td>Compare Settings</td>
<td>25</td>
</tr>
<tr>
<td>Manage Software</td>
<td>25</td>
</tr>
<tr>
<td>Access the Manage Software Screen</td>
<td>26</td>
</tr>
<tr>
<td>View Installed Software Packages</td>
<td>26</td>
</tr>
<tr>
<td>View Available Software Packages</td>
<td>27</td>
</tr>
<tr>
<td>Software Package Information</td>
<td>27</td>
</tr>
<tr>
<td>Run a Series of Install/Uninstall Actions</td>
<td>27</td>
</tr>
<tr>
<td>Manage the Software Repository</td>
<td>28</td>
</tr>
<tr>
<td>Create a Graphics Layout</td>
<td>29</td>
</tr>
<tr>
<td>Start a New Layout</td>
<td>29</td>
</tr>
<tr>
<td>Add Content to Your Layout</td>
<td>30</td>
</tr>
<tr>
<td>Move Layouts to the Versio System</td>
<td>31</td>
</tr>
<tr>
<td>Introduction</td>
<td>31</td>
</tr>
<tr>
<td>Publish Layouts to Versio</td>
<td>31</td>
</tr>
<tr>
<td>Automation Device Server</td>
<td>32</td>
</tr>
<tr>
<td>Introduction</td>
<td>32</td>
</tr>
<tr>
<td>Assumptions and Prerequisites</td>
<td>32</td>
</tr>
<tr>
<td>To Manually start the Device Server</td>
<td>32</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td></td>
</tr>
<tr>
<td>View Device Server Connections .......................................................... 33</td>
<td></td>
</tr>
<tr>
<td>Configure the Device Server Name .......................................................... 34</td>
<td></td>
</tr>
<tr>
<td>Automation Setup ...................................................................................... 35</td>
<td></td>
</tr>
<tr>
<td>Automation Port and Channel Assignments for Versio................................ 36</td>
<td></td>
</tr>
<tr>
<td>About controlling Versio On-board devices ............................................. 37</td>
<td></td>
</tr>
<tr>
<td>Versio configuration for one and two playout ports ................................ 37</td>
<td></td>
</tr>
<tr>
<td>Configuration: 2 ports/4 heads in an Additional Port of Same Disk ......... 37</td>
<td></td>
</tr>
<tr>
<td>Configuration: 1 port/ 2 heads ............................................................... 38</td>
<td></td>
</tr>
<tr>
<td>Automation Database .................................................................................. 39</td>
<td></td>
</tr>
<tr>
<td>About SQL 2012 ....................................................................................... 39</td>
<td></td>
</tr>
<tr>
<td>ASDB Database Upgrade ........................................................................... 39</td>
<td></td>
</tr>
<tr>
<td>Automation Services .................................................................................. 40</td>
<td></td>
</tr>
<tr>
<td>Introduction ............................................................................................. 40</td>
<td></td>
</tr>
<tr>
<td>Available ADC v5.3 Services .................................................................... 40</td>
<td></td>
</tr>
<tr>
<td>Assumptions and Prerequisites .................................................................. 40</td>
<td></td>
</tr>
<tr>
<td>Launching the ADC Services Configuration Manager ............................... 41</td>
<td></td>
</tr>
<tr>
<td>Desktop Icon ............................................................................................ 41</td>
<td></td>
</tr>
<tr>
<td>Enter IP Address in the web browser ....................................................... 41</td>
<td></td>
</tr>
<tr>
<td>Configure Device Server Connection ....................................................... 42</td>
<td></td>
</tr>
<tr>
<td>Starting Configuration with the Magellan Software Manager .................... 42</td>
<td></td>
</tr>
<tr>
<td>Using the Service Configuration Manager ............................................... 42</td>
<td></td>
</tr>
<tr>
<td>View Device Server Connections .............................................................. 45</td>
<td></td>
</tr>
<tr>
<td>Installing Playlist v5.3 on the Workstation ............................................. 46</td>
<td></td>
</tr>
<tr>
<td>Assumptions and Prerequisites .................................................................. 46</td>
<td></td>
</tr>
<tr>
<td>If upgrading from a Previous version ....................................................... 46</td>
<td></td>
</tr>
<tr>
<td>Uninstall Playlist ..................................................................................... 46</td>
<td></td>
</tr>
<tr>
<td>Install Playlist v5.3 .................................................................................. 47</td>
<td></td>
</tr>
<tr>
<td>Validate Connection .................................................................................. 47</td>
<td></td>
</tr>
<tr>
<td>Launch the Playlist v5 Client ..................................................................... 47</td>
<td></td>
</tr>
<tr>
<td>Configure System Connections ............................................................... 48</td>
<td></td>
</tr>
<tr>
<td>Playlist Operations ................................................................................... 52</td>
<td></td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Load a Transmission List for Playout ........................................... 52</td>
<td></td>
</tr>
<tr>
<td>To Run the Transmission List ................................................................ 54</td>
<td></td>
</tr>
<tr>
<td>Manage Playlist v5.3 Configurations ............................................... 56</td>
<td></td>
</tr>
<tr>
<td>Configure Software List Control Panel ........................................... 56</td>
<td></td>
</tr>
<tr>
<td>To customize control panel settings ............................................... 57</td>
<td></td>
</tr>
<tr>
<td>Enable/Disable Buttons ....................................................................... 57</td>
<td></td>
</tr>
<tr>
<td>Set Playlist and Device Servers ........................................................ 58</td>
<td></td>
</tr>
<tr>
<td>Environment Properties ....................................................................... 60</td>
<td></td>
</tr>
<tr>
<td>Configure List Options ....................................................................... 60</td>
<td></td>
</tr>
<tr>
<td>Configure Hardware Control Panel Properties ..................................... 65</td>
<td></td>
</tr>
<tr>
<td>Configure List Appearance Settings ................................................. 70</td>
<td></td>
</tr>
<tr>
<td>To specify Event Colors ...................................................................... 71</td>
<td></td>
</tr>
<tr>
<td>Export and Import Color Settings ...................................................... 74</td>
<td></td>
</tr>
<tr>
<td>To Define Column Settings ................................................................... 74</td>
<td></td>
</tr>
<tr>
<td>Ingest Component Configuration ....................................................... 76</td>
<td></td>
</tr>
<tr>
<td>About Installation and Setup .............................................................. 76</td>
<td></td>
</tr>
<tr>
<td>Motion Configuration .......................................................................... 76</td>
<td></td>
</tr>
<tr>
<td>Client and Server Hardware Requirements .......................................... 76</td>
<td></td>
</tr>
<tr>
<td>Motion 3 Installation: Required component list .................................... 77</td>
<td></td>
</tr>
<tr>
<td>Customer-Specific Settings .................................................................. 78</td>
<td></td>
</tr>
<tr>
<td>Media Client Configuration .................................................................. 78</td>
<td></td>
</tr>
<tr>
<td>Client Hardware Requirements ................................................................ 79</td>
<td></td>
</tr>
<tr>
<td>To Install Media Client on a Workstation ............................................ 79</td>
<td></td>
</tr>
<tr>
<td>Manage the Desktop Shortcut for Media Client ...................................... 80</td>
<td></td>
</tr>
<tr>
<td>To Manage the shortcut on the Desktop .............................................. 81</td>
<td></td>
</tr>
<tr>
<td>Required Material Content Configuration ......................................... 82</td>
<td></td>
</tr>
<tr>
<td>NEXIO Audio Track Routing with ADC Media Client .............................. 87</td>
<td></td>
</tr>
<tr>
<td>Using the AsRun Services functionality with ADC Database and ASDB Database .................................................. 89</td>
<td></td>
</tr>
<tr>
<td>Default settings for Services v5.3.23 and higher: ................................ 90</td>
<td></td>
</tr>
<tr>
<td>About Reconfiguring Data Service ....................................................... 90</td>
<td></td>
</tr>
<tr>
<td>Automation Appendix ........................................................................... 91</td>
<td></td>
</tr>
<tr>
<td>Contents</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Windows 7 Settings</td>
<td>91</td>
</tr>
<tr>
<td>Installing and Enabling IIS on Windows 7</td>
<td>91</td>
</tr>
<tr>
<td>UAC Settings On Windows 7</td>
<td>92</td>
</tr>
<tr>
<td>Device Server and Config Tool Installation</td>
<td>93</td>
</tr>
<tr>
<td>To reinstall the Device Server application (if required)</td>
<td>93</td>
</tr>
<tr>
<td>To Install the Config Tool application (if required)</td>
<td>95</td>
</tr>
<tr>
<td>Install ADC Services</td>
<td>95</td>
</tr>
<tr>
<td>Manually Start the Services from Windows</td>
<td>96</td>
</tr>
<tr>
<td>Stop/Start ADC Services from the Services Configuration Manager</td>
<td>97</td>
</tr>
<tr>
<td>To Stop ADC Services</td>
<td>98</td>
</tr>
<tr>
<td>To Start ADC Services</td>
<td>98</td>
</tr>
<tr>
<td>To Upgrade Services</td>
<td>99</td>
</tr>
<tr>
<td>Configure the Device Server Name</td>
<td>100</td>
</tr>
<tr>
<td>Automation Setup</td>
<td>101</td>
</tr>
<tr>
<td>Appendix: Automation Control of On-Board Devices</td>
<td>103</td>
</tr>
<tr>
<td>Introduction</td>
<td>103</td>
</tr>
<tr>
<td>NEXIO Driver</td>
<td>103</td>
</tr>
<tr>
<td>Audio Track Router Control</td>
<td>103</td>
</tr>
<tr>
<td>Operation Notes</td>
<td>104</td>
</tr>
<tr>
<td>Basic Operation Scenarios</td>
<td>106</td>
</tr>
<tr>
<td>IconStation XML Still Store Driver</td>
<td>106</td>
</tr>
<tr>
<td>Operation Notes</td>
<td>107</td>
</tr>
<tr>
<td>Versio MCS Driver</td>
<td>110</td>
</tr>
<tr>
<td>Multiple Language Setup Appendix</td>
<td>112</td>
</tr>
<tr>
<td>Introduction</td>
<td>112</td>
</tr>
<tr>
<td>Setup Your Systems for Multiple Languages</td>
<td>112</td>
</tr>
<tr>
<td>Versio, Creation Station, and Remote Systems</td>
<td>112</td>
</tr>
<tr>
<td>Configure INI Files on Versio and Creation Station Systems</td>
<td>112</td>
</tr>
</tbody>
</table>
About This Document

Workflow

This document provides tips on setting up specific components of Versio that are necessary for proper operation.

An attempt has been made to organize the sections in this document in a rough sequential installation order.
Update the System Software

Introduction

Software updates can be applied to the Versio system using the latest WIM image. Follow steps in this section to apply the latest image, activate Windows, and register your software.

Download the Latest WIM Image

Download the WIM image on a separate computer.

1. On a separate computer, insert the System Recovery USB stick into an available USB port.
3. Click the link for the latest version.
4. Click the Image link.
5. Download the WIM image to the Recovery folder on the Recovery Boot drive.  
   Note: If there is no Recovery folder in the root, create a New Folder and name it Recovery.

   ![Computer screenshot showing the Recovery folder with the downloaded WIM image]

6. After the image is fully downloaded to the Recovery folder right-click on the Recovery Boot drive and select Eject to safely remove the USB stick.

Apply the Downloaded WIM Image

Note that applying the WIM image will reformat the C:\ drive on the Versio system. If you want to preserve any files on the C:\ drive, back up the files before proceeding.
1. On the Versio system, insert the System Recovery USB stick into an available USB port on the back panel.

2. Restart the system.

3. Continuously press F11 during the POST to open the Boot Menu.

4. Select the USB drive and press ENTER to access the Recovery Desktop.

5. On the Recovery Desktop, double-click the Utility Launcher icon.

6. In the Utility Launcher, click the Imaging button to open the NxImage application.

7. From the File menu, select Format Disk to open the Format Disk dialog.

8. From the Disk Discovery list, select the disk marked System.

9. In the Assign Letter list, select C.

10. In the Format Type list, select NTFS.

11. Click the Format button.

12. In the Format Disk pop-up, click Yes to confirm the formatting of the C:\ drive.

13. When the formatting is complete, click Close to return to the NxImage application.

14. From the File menu, select Apply WIM Image.

15. In the Apply Image dialog, click Open.

16. In the Open dialog, navigate to the Recovery USB drive, open the Recovery folder, and then double-click the downloaded .wim file. The filename displays in the Step (1) field of the Apply Image dialog.
17. In the Apply Image dialog, click the Browse button and select the C:\ drive. Note that you must click Browse to select the destination drive. The drive displays in the Step (2) field.

18. Click the Apply Image button. The progress and status displays in the title bar.

19. When the process is complete, click Close to return to the Recovery Desktop.

20. Go to Start > Computer. Right-click on the Recovery Boot USB drive and select Eject from the menu.

21. Remove the System Recovery USB stick from the back of the system.

22. Shutdown the Versio system (Start > Shutdown).

23. Once the system has completely shut down, press the Power button on the front panel to restart the Versio system.

Activate Windows

*Note:* If a firmware update is required on the Versio system, the firmware update process will start automatically. Allow the process to complete before continuing.

1. Locate and record the license key on the top of the Versio system.

2. If the NEXIO Config window has opened after the system startup requesting application registration, minimize the window and continue with the following Windows activation steps.

3. On the Versio desktop, right-click the Computer icon.

4. Select Properties from the right-click menu.
5. In the System window, click the Change Product Key link at the bottom of the screen. Maximize the window or scroll down if you cannot see the option.

6. Enter the license key and then follow the on screen instructions to complete the activation.

7. Shut down the Versio system (Start > Shut Down). If a message displays indicating additional programs must close, continue with the system shut down.

8. Once the system has completely shut down, press the Power button on the front panel to restart the Versio system. Note that the system start up process might take longer than expected.

Register Software

1. Click Start > Programs > ….. > Software License Key > Registration Manager.

2. In the Registration Manager, click the Register button. The Save As dialog opens.

3. In the File name field, enter a name for the deployment code (.dc) consisting of the system name and the license key. Note that the license key is located on the top of the Versio system.

4. Insert the USB stick into an available USB port on the back panel. Save the .dc file to the USB stick.

5. Email the .dc file and what you are registering to BCD Support at: bcdservice@imaginecommunications.com.

6. Copy the registration code (.rc) that Imagine Communications emails you to the USB stick in the USB port on the back panel (Step 4).

7. Open the Registration Manager (Start > Programs > ….. > Software License Key > Registration Manager) and click Load RC.

8. In the Open dialog, navigate to the USB stick and double-click the .rc file. When you run the system software the registration process completes.
**Recommended Next Steps**

- Change the system name to reflect the role of the Versio system in the broadcast environment.
- Apply a static IP address to the system.
- Set the Versio software configuration options (Versio Console desktop shortcut > Edit Software Settings). See Versio Software Management.
Create a New LLM RAID Set

To create a new LLM RAID set, complete the following steps.

1. Select Start > All Programs > .... > LLM. The LLM window displays showing the available physical drives.

   ![LLM Window](image)

2. From the Physical Disks list, select disks 1-0 through 1-3.

3. Right-click the selected disks and click Initialize from the pop-up list.
4. In the Min Kb/field drop-down list, select 200. This is the recommended setting.

5. In the ID Name Size drop-down list, select 32 UNICODE as the disk size.

6. In the Min Segments field, leave the default as 0. This is the recommended setting.

7. In the Volume Label field, enter a name for the volume. For example, D.

8. In the Selected Physical Drives area, right-click on drive 1-3 and click Parity.
9. The drive icons change to yellow, indicating that they are parity drives.

10. Click OK.

The LLM window appears showing disk D in the Logical Disks area. There are now 15 drives including 4 parity drives configured as logical disk D with drive 2-16 as the hot spare.
Versio Console

Introduction

The Versio Console allows you to view the Versio system details and access the tools for monitoring, updating, and controlling Versio components. You can launch the Versio Console from any system with network access to the Versio device.

Open the Versio Console

1. Open a browser, like Internet Explorer, from a system with network access to the Versio system.
2. In the address bar, enter the IP address of the Versio system. The Versio Console opens in the browser.

**Note:** If the Authentication feature is enabled in the Software Manager, you will be prompted to log-in before you can access the Versio Console. See "User Management" in the Versio Console user guide for more details.

Versio System Information

When the console opens, you can view the Versio system details on the following tabs:

- System
Versio Tools

Access the Versio tools with the links on the right-side.

- Diagnostic Logging: View, search, and monitor the logs on the Versio system.
- Edit Software Settings: Update and manage the configuration and software settings on the Versio system.
- DVE Manager: Define DVE states that are triggered by layout salvos created in the Graphics Control or Manage Layouts tool.
- ADC Services Manager: Perform final ADC services configuration updates for Playlist v5.x Automation.
- Graphics Control: Control output of the graphics layouts manually without automation.
- Manage Layouts: Preview the graphics layout content, create salvos, and update editable layout text and referenced layout files.
Versio Software Management

Introduction

Software Manager is available from the Versio Console and allows you to remotely manage the configuration settings and software installs for the Versio system.

Open Magellan Software Manager

1. Open the Versio Console. See Open the Versio Console for details.
2. Click the Edit Software Settings option. Magellan Software Manager opens.

The Software Manager allows you to manage plug-in configuration settings and software installs on the Versio system.

- Manage Configuration Settings: The Manage Settings screen that displays when you open Software Manager allows you to manage the current configuration of the plug-ins on the Versio system. For details on working with configuration settings see the settings topics, starting with Understanding Configurations.
- Manage Software: The Manage Software screen allows you to manage supported software installations on your Versio system. To access the screen, click the Manage Software for this Device button on the Manage Settings screen. For details on working with software installations see the software management topics, starting with Manage Software.
Understanding Configurations

In Software Manager, configurations manage the settings of the supported applications on the Versio system. Plug-ins allow Software Manager to control the settings of the supported applications remotely. Use the options on the Manage Settings screen to create and compare multiple configurations, push a specific configuration to the Versio system, and view the current configuration on the device.

Magellan Software Manager allows you to work with configurations in the following ways.

Plug-in Revisions

When you Edit Settings for a plug-in and Save Changes, the updates are stored as a revision on the plug-in line. Click the History option on the plug-in line to view, compare, and load revisions in the Manage Settings screen.

Plug-in revisions are stored in the Manage Settings screen and do not change the configuration on the Versio system until they are pushed to the device.

See Edit Plug-in Settings and View Plug-in Revisions for more information.

Plug-in Presets

When you have a revision of the plug-in settings that you want to name and save, use the plug-in preset option. Click the Presets option on the plug-in line to save or load a plug-in preset in the Manage Settings screen. Plug-in presets capture the current settings for an individual plug-in.

Plug-in presets are stored in the Manage Settings screen and do not change the configuration on the Versio system until they are pushed to the device.

See Use Plug-in Presets for more information.

Configuration Presets

When you want to save the current settings of all available plug-ins as one configuration, use the configuration presets option. Click the Save as a New Configuration Preset button near the bottom of the screen to save the settings as a configuration preset. Use the Config Presets tab to load a configuration preset in the Manage Settings screen. Configuration presets capture the current settings for all listed plug-ins as one preset.

Configuration presets are stored in the Manage Settings screen and do not change the configuration on the Versio system until they are pushed to the device.

See Use Configuration Presets for more information.

Pushed Configurations

When you want to apply the plug-in settings currently loaded in the Manage Settings screen to the Versio device, use the Push Config to Device button. The current plug-in settings are applied
on the Versio device and saved as a configuration version on the Device History tab in the Manage Settings screen.

A pushed configuration is the only configuration that updates the configuration on the Versio system.

See Push a Configuration to the Versio System for more information.

Configuration Versions

When you push a configuration to the device, the pushed configuration is saved with a version number on the Device History tab in the Manage Settings screen. Each configuration version contains the state of the pushed plug-in settings, including the revision number for each plug-in.

See View Previous Configuration Versions for more information.

Last Applied Configuration

The last applied configuration is either the last configuration pushed to the Versio system or the last configuration pulled from the Versio system.

Pulled Configurations

When the plug-in settings are updated directly on the Versio system the current device configuration will conflict with the configuration loaded in the Manage Settings screen.

Click the Check State button to see if there is a conflict. If a conflict is detected and you click the Pull Config from Device button, the current device configuration loads in the Manage Settings screen. The pulled configuration becomes the last applied configuration in the Manage Settings screen.

See Check the Device State for more information.

Edit and Save Plug-in Settings

From the Manage Settings screen you can edit settings for supported plug-ins on the Versio system, view settings revisions, and save your current settings as a preset.

Edit Plug-in Settings

When you edit plug-in settings, the saved updates are available in the Manage Settings screen and are stored by Magellan Software Manager as a revision.

Plug-in revisions do not change the configuration on the Versio system until they are pushed to the device.

1. In the Settings section of the Manage Settings screen, click the Edit Settings button on the plug-in line. The Versio settings display on a new screen.
2. Use the tabs on the left to view all the available settings.
3. Update the required options.
4. Click the Save Changes button. The Save dialog opens.
5. Enter a description of the changes and click Save. The Settings screen closes, and plug-in line in the Manage Settings screen displays the MODIFIED using editor highlight.

**View Plug-in Revisions**

After you edit plug-in settings, the saved edits are stored in the Manage Settings screen as a plug-in revision.

1. To access previous plug-in revisions, click the History option on the plug-in line. The Revision History dialog opens with the available revisions.
2. In the dialog you can choose to compare or load revisions.
   - To compare a saved revision with the current settings loaded in the Manage Settings screen, click the Compare button beside the revision in the list. The Compare Settings screen displays. Click Close to return to the Manage Settings screen.
   - To load a previous revision in the Manage Settings screen, select the revision from the list and then click the Load Selected button.

**Use Plug-in Presets**

A plug-in preset captures the current state of the individual plug-in settings. Once you create a plug-in preset you can load the preset at anytime in the Manage Settings screen.

**Create a Plug-in Preset**

1. On the plug-in line, click the Presets option.
2. Select Save as a New Preset from the drop-down list. A pop-up window displays.
3. Enter a name and description for the application preset and then click Save.

**Load a Plug-in Preset**

1. On the plug-in line, click the Presets option.
2. Choose Select and Load a Preset from the drop-down list. A pop-up window displays.
3. Select the preset from the list and click Load. The plug-in line is updated with the loaded preset.

**Use Configuration Presets**

A configuration preset captures the current state of all the plug-in settings loaded in the Manage Settings screen. Once you create a configuration preset you can load the preset at anytime.
Create a Configuration Preset

1. In the Manage Settings screen, click the Save as a New Configuration Preset button near the bottom of the screen to save the settings as a configuration preset.
2. In the dialog, enter a name and description for the configuration preset.
3. Click Save.

Load a Configuration Preset

1. In the Manage Settings screen, switch to the Config Presets tab.
2. Select a saved preset from the list.
3. Click Load Selected. All plug-in settings are updated with the selected preset settings within the Manage Settings screen. Note that to apply the loaded preset to the Versio device, you need to [Push the Configuration to the Versio System](#).

Manage Configurations

The Magellan Software Manager allows you to manage the configurations on your Versio system. From the Manage Settings screen you can push configurations to the Versio system, pull the current configuration from the Versio system, view previous versions, and compare configuration settings.

Load a Configuration

The current plug-in settings displayed in the Manage Settings screen are considered the loaded configuration. You can load a configuration by:

- Editing and saving plug-in settings (see [Edit Plug-in Settings](#)).
- Loading plug-in revisions (see [View Plug-in Revisions](#)).
- Loading presets (see [Load a Plug-in Preset](#) and [Load a Configuration Preset](#)).
- Loading configuration versions (see [Load the Last Applied Configuration](#) and [View Previous Configuration Versions](#)).

Push a Configuration to the Versio System

When you push a configuration to the Versio system the configuration on the device is updated. A pushed configuration is the only configuration that updates the configuration on the Versio system.

1. Load the configuration that you want to push to the Versio system.
2. Click the Push Config to Device button.
3. When prompted, confirm that you want to push the configuration to the device.
Load the Last Applied Configuration

When you load a new configuration the current settings displayed in the Manage Settings screen no longer match the last applied configuration.

To reload the last applied configuration in the Manage Settings screen:
1. Switch to the Device History tab.
2. Click the Load button beside the Last Applied Config heading.

Check the Device State

When the plug-in settings are updated directly on the Versio system without using Magellan Software Manager, the current device configuration will conflict with the last applied configuration.

To check the current device state against the last applied configuration, complete the following steps.
1. On the Device History tab, click the Load button beside the Last Applied Config heading. The last applied configuration loads in the Manage Settings screen.
2. To check the current device configuration, click the Check State button. Magellan Software Manager checks the current device state against the last applied configuration.
   If the configuration on the device differs from the last applied configuration, a highlighted area displays in the Device State section and on the plug-in line.
3. Click the Compare Physical Device Setting button on the plug-in lines to compare the device settings with the current plug-in settings.
4. On the Compare Settings screen, review the differences between the two sets of settings to decide if you want to either overwrite the current device configuration with the last applied configuration or leave the current device configuration untouched. Then click Close to return to the Manage Settings screen.
   • If you want to overwrite the current device configuration with the last applied configuration, click the Push Config to Device button.
   • If you want to leave the current device configuration untouched, pull the device configuration to Magellan Software Manager by clicking the Pull Config from Device button. This ensures the configurations are in sync. The configuration from the device loads in the Manage Settings screen and is treated as the last applied configuration by Magellan Software Manager.

View Previous Configuration Versions

When you push configurations to the Versio system, the pushed configurations are stored in the Manage Settings screen as a configuration version on the Device History tab.
1. To access versions of previously pushed configurations, switch to the Device History tab.
2. From the Device History tab, you can load a specific configuration version in the Manage Settings screen.

- To load the last configuration applied on the Versio system, click the Load button beside the Last Applied Config heading.
- To load a previously applied configuration, select the version from the list and click the Load Selected button.

## Compare Settings

Magellan Software Manager allows you to compare various states of plug-in settings. The available options depend on the last actions taken in the Manage Settings screen and on the Versio system.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History option on plug-in line</td>
<td>Compares the current plug-in settings with a previous plug-in revision. Click the History option and then click the Compare button beside the appropriate revision. This option is always available.</td>
</tr>
<tr>
<td>Compare Last Applied Settings button on plug-in line</td>
<td>Compares the current plug-in settings with the last configuration that was pushed or pulled. This option displays when the current settings are different from the last applied settings.</td>
</tr>
<tr>
<td>Compare Physical Device Settings button on plug-in line</td>
<td>Compares the current plug-in settings with the current configuration on the Versio system. This option displays when you click the Check States button and the current plug-in settings in the Manage Settings screen are different from the plug-in settings on the Versio system.</td>
</tr>
</tbody>
</table>

## Manage Software

The Software Manager allows you to manage supported software installations on your Versio system. From the Manage Software screen you can install and uninstall supported software packages, view available software, and manage the available software in the software repository.
Access the Manage Software Screen

To access the Manage Software screen, click the Manage Software for this Device button on the bottom left corner of Manage Settings screen.

View Installed Software Packages

The Installed Software tab lists the supported software that is currently installed on the Versio system.

1. On the Installed Software tab, select a software package from the list.
2. To uninstall a software package, click the Uninstall option on the software package line. A red Marked for Uninstall highlight displays on the line and the uninstall is added as an action to the Actions list on the right.

- To complete the uninstall, click the Validate and Begin Install/Uninstall button above the Actions list and follow the prompts.
- To remove the uninstall action from the Actions list, click the X on the action line.
View Available Software Packages

The Available Software tab lists the all the supported software packages available for install or uninstall. The list includes all the versions of each software package currently available in the Software Repository.

1. Switch to the Available Software tab, to view the available software.
2. Click the name on the software package line to view the installable versions.
3. To uninstall a specific version, click the Uninstall option on the appropriate line. A red Marked for Uninstall highlight displays on the line and the uninstall is added as an action to the Actions list on the right.
   • To complete the uninstall, click the Validate and Begin Install/Uninstall button above the Actions list and follow the prompts.
   • To remove the uninstall action from the Actions list, click the X on the action line.
4. To install a specific version, click the Install option on the appropriate line. A green Marked for Install highlight displays on the line and the install is added as an action to the Actions list on the right.
   • To complete the install, click the Validate and Begin Install/Uninstall button above the Actions list and follow the prompts.
   • To remove the install action from the Actions list, click the X on the action line.

Software Package Information

The build information for the software package selected on the Installed Software tab or the Available Software tab displays to the left of the Actions list and includes the following:

- Copy Info Button: Copies the listed build details to the Windows clipboard. You can then paste the information into another document.
- Release Notes Tab: Displays the release notes for the selected software package if available.
- User Notes Tab: Allows you to enter notes about the selected software package. The notes save automatically.

Run a Series of Install/Uninstall Actions

The Actions list is useful for running a series of install/uninstall actions and can help to ensure the actions occur in the proper order; for example, if one software version must be uninstalled before a new version is installed.

To create and run a series of installs/uninstalls:

1. Switch to the Available Software tab.
2. Click the name on the software package line to view the installable versions.
3. To uninstall a specific version, click the Uninstall option on the appropriate line. A red Marked for Uninstall highlight displays on the line and the uninstall is added as an action to the Actions list on the right.
4. To install a specific version, click the Install option on the appropriate line. A green Marked for Install highlight displays on the line and the install is added as an action to the Actions list on the right.

5. To reorder the actions, drag the install/uninstall actions up or down to a new location in list.

6. To remove an action from the Actions list, click the X on the action line.

7. To run the series of actions, click the Validate and Begin Install/Uninstall button above the Actions list and follow the prompts.

**Manage the Software Repository**

The Software Repository allows you to manage which software packages are available for install/uninstall on the Available Software tab. Supported software packages have a .hpkg file extension.

1. To view the Software Repository screen, switch to the Available Software tab.

2. Click the Upload/Manage Software Repository button. The Software Repository screen displays.

3. To add a new software package, click the Upload New Software button in the top-right corner of the screen. Use the Upload Software dialog to add the .hpkg file to the Software Repository.

   Once multiple software packages are uploaded to the Software Repository list, you can click the name of the software package to expand the list of available versions.

4. To delete a specific version, select the version in the Software Repository list and then click the Remove Version button.
Create a Graphics Layout

Graphics layouts are created on a dedicated system running the Versio Creation Station. After you create your graphics layouts using the Creation Station tools you can publish the layouts to the Versio system and include the layouts as secondary events in the automation playlist.

The Version Creation Station includes offline versions of the browser-based Versio Console tools as well as the IconStation application.

Note: See the full Versio Creation Station user guide for complete details on creating and managing layouts.

Start a New Layout

1. On the dedicated Creation Station system, double-click the Versio Console shortcut on the desktop. An offline version of the Versio Console opens in a browser.

2. Click the Manage Layouts option. The Manage Layouts tool opens with the layouts listed that are available on the offline system.

3. In the offline Manage Layouts tool click the Create New Layout button above the layout list.

4. In the layout dialog, select a layer for the new layout and then enter a name for the layout. The layer corresponds to the five layout tabs in the IconStation application.

5. Click the New Layout button in the dialog. The IconStation application opens with the new layout name displayed on the appropriate layout tab.
Add Content to Your Layout

The buttons on the IconStation toolbar allow you to add content to your layout. The following example describes how to add an image to your layout, but you can also add other text, graphic, and audio items. See the full Versio Creation Station user guide for details.

1. To add an image to your layout, click the Image button on the toolbar.

2. Drag a box in the workspace to create an Image item box. The item box is a container that holds the image and determines the size and position of the graphic.

When you select the Image item box in the workspace, the item details display below the workspace. If you deselect the item by clicking the workspace, the Safe Title Area options display.

3. Open the Image Editor using one of the following methods.
   - Double-click on the Image item box in the workspace.
   - Select the Image item box in the workspace and then click the Edit button located with the image details below the workspace.
   - Double-click the Image item in the Items list on the Control panel.

   **Tip:** The Content Editors allow you to add content to your item boxes and define the item details. Most Content Editors include a Content tab and an Audio tab.

4. In the Image Editor, select the Files option from the Source Type drop-down list. This option allows you to open a single image file.

5. Click the Browse button.

6. In the Browsing Options dialog, select the Local Files Browsing option, and then click OK.

   The Local Files Browsing option selects a file located on your local system or on your local network. The HTTP/FTP File browsing option selects a file located on an FTP or website.

7. In the Open dialog, navigate to and select your image file and then click Open. A preview of the image displays in the Image Editor.

8. On the Content tab, select the Scale checkbox. Then set the Scale to Fill Region and the Maintain Aspect Ratio options.

   **Tip:** The selected scaling options resize the image to fit the item box without distorting the image.

9. Click the Save button. The Image Editor closes and the image displays in the workspace.

   You can continue to use the buttons on the toolbar and the options in the Content Editors to add more content to your layout.
Move Layouts to the Versio System

Introduction

Graphics layouts are created on the Creation Station system and must be moved to the Versio system for playout. Steps for publishing a layout directly to the Versio system are described below.

Note: For details on using the Connectus purchase option to move layouts to Versio, see the Connectus User Guide.

Publish Layouts to Versio

As you add items to the layout in IconStation, the layout is saved automatically on the Versio Creation Station system. When you return to the browser with the offline Versio Console open, you can use the Manage Layouts tool to publish layouts to the Versio system.

1. Open the offline Manage Layouts tool on the Creation Station system (Versio Console desktop shortcut > Manage Layouts).
2. Choose to publish one or more layouts.
   - To publish one layout, click the Publish button on the layout line.
   - To publish multiple layouts, select the check boxes on the layout lines and then click the Publish Selected Layouts button at the top of the layout list.
3. In the Publish dialog that opens, select the check box for the Versio system.
   If a Versio system is not listed:
   a. Click the Add a Versio button in the Publish dialog.
   b. In the dialog that opens, enter the Versio system name in the Device ID field.
   c. Enter the IP address of the Versio system in the IP Address/Host field.
   d. Click the Add Device button. The Versio system details display in the list.
   e. Click Save. The dialog closes and the Versio system is listed in the Publish dialog.
4. In the Publish dialog, click the Publish button. The layouts are published to the Versio system.

Once the graphics layouts are available on the Versio system, you can add them to a playlist as a secondary event for output.
Automation Device Server

Introduction

The Automation Device Server is the heart of the automation system. The Device Server controls devices for playout or record either through RS-422 serial connections or an Ethernet connection. The Device Server runs lists (playlists, media lists, etc.) and communicates with remote clients (e.g. Playlist v5.3, Air Client, Media Client, etc.) through a Local Area Network (LAN) connection.

Assumptions and Prerequisites

The following assumptions and prerequisites are made regarding the base implementations in place prior to the processes listed in this section.

- Persons doing the installation and setup have Administration rights on the computer.
- Windows 7 and IIs7 are installed and setup, and UAC settings are set on the Versio box. This should be included in the standard Versio image.
  - For details see Automation Appendix > Enable IIS Settings and Automation Appendix > UAC Settings. Also reference ADC v5.2 Services Reference and ADC’s Windows 7 Install Guide.
- Each instance of automation Device Server on the system network has a unique name.
- Database is already installed on the same computer that Device Server and Services are being installed on (i.e. the Versio box).
- It is assumed the Device Server and Config Tool have been installed and are running. For details see Automation Appendix.

Reference Note: For details on all procedures in this section see Versio Automation Device Server v12 and ConfigManager Installation and Operations Reference.

IMPORTANT: Functionality updates have produced a revlock condition with Playlist v5.3, Services 5.3, and Device Server 12.21.27M. Versio 2.0 requires Playlist v5.3, Services 5.3, and Device Server 12.21.27M or higher be installed. Since these versions are not back compatible, when updating systems all components must be updated to these levels.

To Manually start the Device Server

Use this procedure to start the Device Server.
1. On the Device Server’s desktop, double-click the Device Server icon. This launches the Device Server application.

   **Note:** This icon may be renamed in an installation.

2. The system prompts to select the active network.

3. Select a network interface and then click **OK**. Settings are saved in the network.ini file.

4. When the Device Server application is running, an application bar - similar to the one below - is displayed at the top of the screen. This bar can be minimized to the tray or repositioned on the screen as required.

### View Device Server Connections

Use the following procedure to view of the Device Server and client applications currently logged into this Device Server.

1. Ensure Device Server is launched.

2. From the Device Server main menu select **View > Connections**. The Connections window is displayed showing all connections made via the automation Network to this Device Server.

   - Example: If Services are not installed and launched, they are not shown available.

   ![Connections Window](image)

   - Example: If Services are launched, they are shown as available.
3. From the Connections window main menu an operator can choose:
   - File > Close: Close the Connections window
   - View > Refresh: (or Press F5) to refresh the display

Configure the Device Server Name

Always start the Versio configuration process with the Magellan Software Manager. Before making any configuration changes in the Automation Device Server, Services, or Iconstation Monitor Config tool, configure the Device Server name in the Magellan Software Manager, which is accessible from a remote computer with network access to the Versio system.

Pushes from the Magellan Software Manager are to local systems on the Versio box only.

Example: Automation Services can reside locally on the Versio box or on another computer.

- If they reside locally – and the default services names are used- changes to the Device Name are pushed to the Automation Services.

Example: Automation Services reside on another computer or have been renamed.

In the following cases the operator must then manually confirm the Device Server names match across the Automation Device Server, Services, Iconstation Monitor Config tool, and Magellan Software Manager.

- If they reside on another computer, then the changes are not pushed to them.
If the Services have already been configured to have a different name, then the changes are not pushed to them.

Automation Setup

1. Open the Versio Console:

   - From the Versio desktop click the Versio Console icon.
   Or
   - Open a browser, like Internet Explorer, from a system with network access to the Versio system. In the address bar, enter the IP address of the Versio system. The Versio Console opens in the browser.

2. Click the Edit Software Settings option. Magellan Software Manager opens.

3. In the Settings Plug-ins section of the Manage Settings screen, click the Edit Settings button on the Versio plug-in line. The Versio settings display on a new screen.

4. Switch to the General tab to ensure:
   - "Start Local ADC Server" is checked. (Default)
   - Automation Device Server Name: Ensure the name specified in the Automation Device Server Name matches the name specified for the Device Server. (Default: Versio-DS)
5. Click Save Changes.
6. In the comment dialog enter a description of the change, then click **Save**.
7. Push the configuration change.
8. On the warning dialog check to enable overwrite, then click **Push**.
9. On the confirmation dialog click **Continue**.
   
   **Note:** This action will stop playout and restart the Versio system.
10. This updates Versio parameters for automatic start.

---

### Automation Port and Channel Assignments for Versio

The following information outlines the **preset** port and channel assignments for Automation Inputs and Outputs from Versio. The following image is a representation of the Broadcast I/O ports located on the back of the Versio box.

<table>
<thead>
<tr>
<th>Video I/O</th>
<th>Type</th>
<th>Function</th>
<th>Automation Channel</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Out 1)</td>
<td>Video Out</td>
<td>Branded: Video</td>
<td>Channel:1, 2, 3</td>
<td>Channel 1: Live Output</td>
</tr>
<tr>
<td>Video I/O</td>
<td>Type</td>
<td>Function and Graphics</td>
<td>Automation Channel</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-----------------------------</td>
<td>----------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Depending on Versio Master Control Switcher setting)</td>
<td>Channel 2: Decoder 3 on NEXIO Channel 3: Decoder 4 on NexioCH4</td>
</tr>
<tr>
<td>2 (IN 1)</td>
<td>Input</td>
<td>Live Input</td>
<td>-----</td>
<td>-----</td>
</tr>
<tr>
<td>3 (Out 2)</td>
<td>Video Out</td>
<td>Clean: Video Only</td>
<td>Channel 1: 2, 3</td>
<td>Channel 1: Live Output Channel 2: Decoder 3 on Nexio Channel 3: Decoder 4 on NexioCH4</td>
</tr>
<tr>
<td>4 (IN 2)</td>
<td>Input</td>
<td>Record In</td>
<td>NEXIO Stream 6</td>
<td>Encoder on NEXIO</td>
</tr>
<tr>
<td>9 (REF)</td>
<td>Reference Input</td>
<td>Timecode / Sync</td>
<td>-----</td>
<td>-----</td>
</tr>
</tbody>
</table>

### About controlling Versio On-board devices

For information on controlling On-board devices (NEXIO, IconStation XML, Versio MCS) see [Appendix: Automation Control of On-Board Devices](#).

### Versio configuration for one and two playout ports

This section defines basic Versio one playout port and two playout port configuration scenarios. Each configuration specifies:

- The shortest clip value where the list will operate reliably when the same duration of events are played back to back.
- If the short clip is preceded and followed by a longer clip.

#### Configuration: 2 ports/4 heads in an Additional Port of Same Disk

When Versio is configured for two playout ports, the ports will be playing in an A/B/A/B sequence.

With both Nexio Ports assigned to the Tx List and the standard Preroll of 3 seconds and Postroll of 1 second configured, Versio DS 12.21.24.3M can play clips with a minimum duration of 2 seconds and 18 frames.
With both Nexio Ports assigned to the Tx List and a modified Preroll of 2 seconds and Postroll of 1 second configured, Versio DS 12.21.24.3M can play clips with a minimum duration of 1 second and 18 frames.

The same minimum values above are also what will play correctly when the short clip is preceded and followed by a longer clip in this configuration.

**Configuration: 1 port/ 2 heads**

With one Nexio Port assigned to the Tx List and the standard Preroll of 3 seconds and Postroll of 1 second configured, Versio DS 12.21.24.3M can play clips with a minimum duration of 4 seconds and 3 frames.

With both Nexio Ports assigned to the Tx List and a modified Preroll of 2 seconds and Postroll of 1 second configured, Versio DS 12.21.24.3M can play clips with a minimum duration of 3 seconds and 3 frames.

The same minimum values above are also what will play correctly when the short clip is preceded and followed by a longer clip in this configuration.
Automation Database

About SQL 2012

Versio 2.0 is configured to find the Automation ASDB Database and the ADC Database and on the D: drive. For instructions on creating a database, migrating an existing database from another location, restoring a database, etc., please reference the following documentation:

- ADC_SQL_Server_2012_Express_Installation_Guide
- ADC_SQL_Server_2012_Installation_Guide

ASDB Database Upgrade

SQL database is installed as part of the standard image; **for a standalone Versio system, the database will typically reside on the Versio box.** When upgrading a Versio system use the following procedure to ensure the DB version supports the current functionality.

1. Select Start\All Programs\Microsoft SQL Server 2012\SQL Server Management Studio.
2. Click Connect in the Connect to Server window.
3. Select File\Open\File\browse to the ADC Automation folder\open the DB Upgrade folder\select Upgrade_All_ADC_SQL_2012_V1_2.sql and hit Open.
   
   **IMPORTANT: The Script is included with the image upgrade package.**

4. Click on Execute in the upper left of the SQL Management Studio, (it has a red exclamation mark in front of it).

5. Verify that Command(s) completed successfully is displayed in the Messages area of the SQL Management Studio, (lower middle).

6. Close the SQL Management Studio.
Automation Services

Introduction

ADC v5 Services are individual Windows Service instances (i.e. self-hosted) with each service representing a specific piece of functionality within the ADC automation system. The configuration information for each service is held in the service's xml file.

Available ADC v5.3 Services

- ADC AsRun Service: Saves and transfers information about played out events. (AsRunService.xml)
- ADC Error Reporting Service: Provides extended error reporting functionality. (ErrorReportingService.xml)
- ADC Data Service: Provides access to the ADC database and notifications about data changes. (DataService.xml)
- ADC Device Service: Provides ability to communicate and control the broadcast devices and client services. (DeviceService.xml)
- ADC List Service: Provides playlists control and edit functionality. (ListService.xml)
- ADC Manager Service: Provides control of the other ADC Services. (ManagerService.xml)
- ADC Material Service: All DB writes go through this service interface. (MaterialService.xml)
- ADC Timecode Service: Provides server timecode. (TimecodeService.xml)
- ADC Integration Service: A messaging platform comprised of adapters that allows transfer of messages from external systems like Traffic or PSIP generator to the Automation and vice versa. (IntegrationService.xml)

Assumptions and Prerequisites

The following assumptions and prerequisites are made regarding the base implementations in place prior to the processes listed in this section.

- Persons doing the installation and setup have Administration rights on the computer.
- Windows Firewall Service is disabled on the computer(s) where Playlist v5 and Services are installed.
- Windows 7 and IIs7 are installed and setup, and UAC settings are set. This should be included in the standard Versio image.
• For details see Automation Appendix > Enable IIS Settings and Automation Appendix > UAC Settings.

• For details on procedures in this section reference ADC v5.2 Services Reference and ADC's Windows 7 Install Guide.

- Each instance of automation Device Server on the system network has a unique name.
- Device Server and automation database (SQLExpress 2012 assumed) are already installed on the same computer that Services are being installed on (i.e. the Versio box).
- It is assumed the Services have been installed and are running. For details see Automation Appendix.

- Always start the Versio configuration process with the Magellan Software Manager. Before making any configuration changes in the Automation Device Server, Services, or Iconstation Monitor Config tool, configure the Device Server name in the Magellan Software Manager, which is accessible from a remote computer with network access to the Versio system. For details see Automation Appendix: Configure the Device Server Name.

IMPORTANT: Functionality updates have produced a revlock condition with Playlist v5.3, Services 5.3, and Device Server 12.21.27M. Versio 2.0 requires Playlist v5.3, Services 5.3, and Device Server 12.21.27M or higher be installed. Since these versions are not back compatible, when updating systems all components must be updated to these levels.

Launching the ADC Services Configuration Manager

There are two methods for launching the ADC Services Configuration Manager:

Desktop Icon

1. Ensure all Services are started.
2. Ensure an ADC Device Server is started on the network.
3. Click the Services Configuration Manager icon on the local desktop to launch the ADC Services Configuration Manager.

Enter IP Address in the web browser

1. Ensure all Services are started.
2. Ensure an ADC Device Server is started on the network.
3. Open your web browser and enter the location of the Services Configuration Manager: This launches the ADC Services Configuration Manager.
Address Syntax: http://“IPAddress or NetBios Name”:8091/

- **Examples**: The following are provided as examples only. Your IP Address or NetBios name may be different.
  - Using Local Host: [http://localhost:8091/](http://localhost:8091/)  (works only if ADC services are installed on your local machine)

---

## Configure Device Server Connection

Use the following steps to configure the Device Server connection on an automation service using Services Configuration Manager. Configure the Device Server to connect to on the following automation services: AsRun Service, Timecode Service, Error Reporting Service, Device Service, List Service.

### Starting Configuration with the Magellan Software Manager

Always start the Versio configuration process with the Magellan Software Manager. Before making any configuration changes in the Automation Device Server, Services, or Iconstation Monitor Config tool, configure the Device Server name in the Magellan Software Manager, which is accessible from a remote computer with network access to the Versio system. For details see [Automation Appendix: Configure the Device Server Name](#).

### Using the Service Configuration Manager

**Note**: Material Service and Data Service do not have a Device Server setup component.

1. Launch the Manager Service Client.

   ![ADC Services Configuration Manager]

   *Table: ADC Services Configuration Manager*

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Host Name</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC Integration Service</td>
<td>IntegrationService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Material Service</td>
<td>MaterialService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Data Service</td>
<td>DataService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Timecode Service</td>
<td>TimecodeService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Error Reporting Service</td>
<td>ErrorReportingService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC AsRun Service</td>
<td>AsRunService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Device Service</td>
<td>DeviceService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC List Service</td>
<td>ListService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
</tbody>
</table>

2. Click on the Service name (Timecode Service, Error Reporting Service, AsRun Service, Device Service, List Service, ). This expands to display the available options. The following screen is provided for reference.

   **Note**: Click on the Service name again to collapse the options display.
3. **Application Name**: For each service (AsRun Service, Timecode Service, Error Reporting Service, Device Service, List Service) use the Default name or (recommended) specify a unique name for each instance of a Service.

*Note: Since services can connect across multiple Device Servers (and there can be different sets of services within a system), it is strongly recommended the name of each service instance be uniquely designated for easier tracking. (e.g. DS1AsRunSrvc, DS2AsRunSrvc, etc.)*

- **Example**: The following is an example of the standard default naming for a Service on initial startup.

  ![Application Name AsRunSrvc](image)

- **Example**: The following is an example unique naming for a Service.

  ![Application Name DSAsRunSrvc](image)

- **Example**: The following is an example unique naming where multiple instances of Services are installed across a network.

  ![Application Name DS1AsRunSrvc](image)
  ![Application Name DS2AsRunSrvc](image)

4. For each service (AsRun Service, Timecode Service, Error Reporting Service, Device Service, List Service) click the Configure button. A pocket display of the configuration tab page slides out from the right side of the screen.

*Note: Click on the faded bar just visible before the configuration window to hide the configuration display.*

Each Configure screen for the services shown above will have a Device Servers connection component. For a single instance of Versio, on installation the system defaults to the Versio Device Server.
Note: On initial Services installation for a Versio, the standard default Device Server name is Versio-DS.

5. (Option) To add a differently named Device Server (For example, if connecting across multiple Versio Device Servers that are present on the same network):
   - Select the Device Server name (e.g. Versio-DS2) from a dropdown list of Device Servers on the network.
   - Ensure Connect is checked. (default)
   - Click ‘+’. The selected Device Server (e.g. Versio-DS2) is added to the list of connected Device Servers.

6. (Option) To remove a Device Server entry (e.g. Versio-DS2) click the ‘−’ button to the right of the entry. The system will prompt for confirmation of the action.

7. When finished click Save.
View Device Server Connections

Use the following procedure to view of the Device Server and client applications currently logged into this Device Server.

1. Ensure Device Server is launched.

2. From the Device Server main menu select View > Connections. The Connections window is displayed showing all connections made via the automation Network to this Device Server. All five automation services should be displayed: AsRun Service, Timecode Service, Error Reporting Service, Device Service, and List Service.

3. From the Connections window main menu an operator can choose:
   - File > Close: Close the Connections window
   - View > Refresh: (or Press F5) to refresh the display
Installing Playlist v5.3 on the Workstation

Assumptions and Prerequisites

The following assumptions and prerequisites are made regarding the base implementations in place prior to the processes listed in this section.

- Persons doing the installation and setup have Administration rights on the computer.
- Windows 7 installed and setup and UAC settings are set.
  - For details see Automation Appendix > UAC Settings. Also reference ADC's Windows 7 Install Guide.

Reference Note: For details on all procedures in this section see Playlist v5.3 Operations and Installation Reference – section: Playlist v5 Installation and Setup.

IMPORTANT: Functionality updates have produced a revlock condition with Playlist v5.3, Services 5.3, and Device Server 12.21.27M. Versio 2.0 requires Playlist v5.3, Services 5.3, and Device Server 12.21.27M or higher be installed. Since these versions are not back compatible, when updating systems all components must be updated to these levels.

If upgrading from a Previous version

When upgrading a Playlist installation it is a good practice to uninstall previous versions prior to installing the new version.

Uninstall Playlist

1. Add/Remove Programs -> Playlist -> Select Uninstall.
2. Delete the C:\users\<user>\AppData\Local\AirClient.s3db file. This file is recreated on installation. If there were sufficient changes between versions to create an incompatibility and the previous .s3db file is not removed, then previous settings can be maintained and the system will not work.
3. Delete the C:\Program Files (x86)\.....\Playlist folder. This removes all old config settings. If you plan to reuse the previous version’s settings, then do not remove. However, be aware that if there were sufficient changes between versions to create an incompatibility, it is prudent to remove this folder.
4. If present, delete the C:\ProgramData\.....\AirClient folder. This file is recreated on installation. If there were sufficient changes between versions to create an incompatibility and the previous graphicssettings.xml file is not removed, then previous settings can be maintained and the system will not work.

5. Install the latest officially released playlist version that matches the ADC Services version you have installed.

**IMPORTANT:** The version of Playlist v5 Client must match the level of the Services being run. For example, if running 5.3.50.1 of the Services then the Playlist v5 Client version must be v5.3.50.x, where ‘x’ can be any number.

6. When ready Install the new Playlist version.

---

**Install Playlist v5.3**

Use this procedure to install the Playlist v5.3.

1. On the Client workstation run the Playlist-client-5.3.xx.msi file to install Playlist v5 client. This installs the correct version of Playlist v5 along with the correct version of Content Control Center.

**IMPORTANT:** The version of Playlist v5 Client must match the level of the Services being run. For example, if running 5.3.50.1 of the Services then the Playlist v5 Client version must be v5.3.50.x, where ‘x’ can be any number.

2. On the Welcome screen click **Next**.

3. On the Destination Folder screen:
   - Specify the installation location. Recommended: Accept default.
   - Choose to install the application for Everyone.

4. On the Ready to install screen click **Install**.

5. On the Installing screen the status bar indicates the installation progress.

6. On the Completed screen click **Finish**.

---

**Validate Connection**

Use the following procedures to validate connection.

**Launch the Playlist v5 Client**

Use the following procedure to launch Playlist v5.

1. Ensure the Device Servers configured in the Services are running.
2. Click the Playlist icon ( ) on the desktop.

3. Wait for the Automation Playlist v5 workspace options to paint. This may take a few minutes.

Configure System Connections

Once the Playlist v5 GUI is launched, use the following procedure to configure client connections to a Device Server, how thumbnails are displayed, and settings for the IconStation graphics plugin (used for the Versio tab).

About Multiple Device Server Connections: Playlist v5 supports single or multiple Device Server connections. The system scans the network for Device Servers configured in the services and lists them in the “View List” dialog. From here the operator can select the Device Server to use when opening lists.

Note: Lists open in Playlistv5 that are hosted on a Device Server, which is subsequently removed from the configuration, are closed.

1. On the main menu select Settings >Connection Configurations. The Configuration screen is displayed.
The Service / State grid provides a quick operational status view of the automation services:

- Red (): Not connected or Stopped
- Green (): Connected and Running

2. Connection Configuration.

- **Business Services Host / Application Server Name:** Specify the IP Address of the machine which has the installed services. (For example: 127.0.0.1 (Local))
  
  **IMPORTANT:** All of the Services must be configured and running.

- **Available Device Servers:** This pane lists all available Device Servers configured in the Services. Check the Device Server(s) to connect to.
- Click **Save.** This saves the configuration entries.
- Click **Connect.**
The Service / State grid icons should all turn green (●): Connected and Running.

**Note:** If the Connect button is clicked and the List service is not running the following message is displayed: "Connection to List Service was unsuccessful."

3. **Thumbnail Configuration:** Use these parameters to choose how thumbnails should be displayed.

   - Thumbnails are visible: Check to enable visibility.
   - Use default thumbnails: Check to use defaults.
   - Click **Save**.

4. **IconStation Plugin Settings:** Use these parameters to specify settings for the IconStation graphics plugin connection. This configuration is for the Versio tab on the UI.

   - Host Name: Host name of the IconStation graphics component. (Default: blank)
   - Port: Specify the IconStation Communications port to use. (Default: 8890)
   - Page: Specify the IconStation Graphics page to use. (Default: Versio\ContentEditor.html)
   - Click **Save**.

Once properly set up the IconStation view can be launched by selecting the Versio tab in the right hand display pane.
5. (Option) If configuration setting changes were made across multiple areas, the operator can save all changes by clicking **Save All**.

6. Click the ‘x’ in the upper right corner of the Configuration screen to close the screen.

**Testing the System Connection**

1. From the main menu under **Workspace>** select a workspace type (e.g. Playlist). Options are:
   - Playlist only view
   - Playlist & Timeline view
   - Playlist & Dashboard view

2. From the main menu select **Resources > View List**. This opens the Select Lists dialog.

3. From the Select Lists dialog highlight the desired Device Server, choose (check) a List, and then click **OK**.

4. If all is correctly setup, the playlist tab is displayed with a running timecode.
5. **Load a Transmission List for Playout.**

---

**Playlist Operations**

Then following procedures are provided for reference.

**Load a Transmission List for Playout**

Use this procedure to load a playlist. If this operation is performed on an already open list it will overwrite any events that are currently in the list with the Playlist file that is selected. This is intended to be used when the Transmission List is off the air or for Record Lists.

**WARNING:** If Load List is selected an on-air Transmission List, the on-air list will be taken off the air!

**About Multiple Device Server Connections:** Playlist v5 supports single or multiple Device Server connections. The system scans the network for Device Servers configured in the services and lists them in the “View List” dialog. From here the operator can select the Device Server to use when opening lists.

**Note:** Lists open in Playlistv5 that are hosted on a Device Server, which is subsequently removed from the configuration, are closed.

1. From the main menu under **Workspace**> select a workspace type (e.g. Playlist). Options are:
   - Playlist only view
   - Playlist & Timeline view
• Playlist & Dashboard view
• Dashboard only

Note: The Dashboard Only view is a minimal representation of a currently running list.

2. From the main menu select Resources > View List. This opens the Select Lists dialog.

3. From the Select Lists dialog highlight the desired Device Server, choose (check) a List, and then click OK.

4. If all is correctly setup, the playlist tab is displayed with a running timecode.

5. Right click on the playlist area and from the context menu select Load List. Or from the main menu select File > Load Playlist. The Load Playlist dialog is displayed.

   • No more than 12500 events can be added into an ADC Transmission List.
   • Once the list has been loaded additional lists can be inserted and/or appended to the playlist by using the right click menu or File menu options.

   Note: Using Load List/ Load Playlist overwrites any events that are currently in the Transmission List with the playlist file that is selected. This will stop an event that is currently
playing On Air. This is intended to be used for Record Lists or when the Transmission list is off the air.

To Run the Transmission List

With a playlist loaded use the following procedure to take the list to air.

1. From the main menu select **Tools > Playlist > Control Panel**. This launches the Software List Control Panel. On the panel click...PrgRun (하셨음)

2. Selecting PrgRun (了吧) threads up all available devices that have the IDs located in the device. Typically only the disk is able to thread and any Switch Only sources such as Studio or Network sources.
3. With the Play list loaded and cued up, click...Play () on the Software Control Panel.

The play list starts playing. If the system is configured correctly, the switcher switches these events to the program output of the switcher. Each event plays for the duration designated on play list.
Manage Playlist v5.3 Configurations

Configure Software List Control Panel

In Playlist v5 a single panel can be used to control different- and multiple- lists. It is possible to configure multiple, distinct instances of the same control (such as Play), each for a different list or lists. This capability supports gang control of multiple lists and scenarios where the operator wants to have multiple lists' controls onscreen simultaneously.

By default every playlist is controlled separately. The Control Panel controls the selected playlist. Control Panel settings follow the list selection, however the control panel settings can be locked by clicking the Lock settings button to avoid accidental list selections.

Control Panel actions are grouped using different colors.

- Green - actions for the actual playing event and ready to play
- Blue - actions for the next playing event and protect/on-air switch
- Yellow - postponing actions
- Red - leaving or deleting actions

- **Control Panel Settings Toggle**: Toggle On/Off the settings panel.
- **Control Panel Settings Lock**: When “ON” panel setting remain regardless of the list selection. When “OFF” panel settings follow the list selection.
To customize control panel settings

To customize control panel settings for the actual playlist, click the Settings button. Here you can enable/disable control buttons, and also have the ability to add/remove playlists to control them together. Adjusted settings are bound to the checked playlists.

Launch the Control Panel

Use this procedure to launch the software control panel.

1. From the main menu select **Tools > Playlist > Control Panel** or press **<F4>**. This launches the software control panel.
2. On the panel, click the **Control Panel Settings Toggle** button ( ) to toggle on and display the Control Panel button settings.
3. The panel can now be configured.

Enable/Disable Buttons

Use the checkboxes to designate active and inactive buttons on the list pane. See below for a list of the buttons and their functions.

1. On the panel, click the **Control Panel Settings Toggle** button ( ) to toggle on and display the List Control Panel button settings.
2. Click the **Button Settings Toggle** to on ( ). The **List Settings** button to toggled off.
3. Enable/Disable function buttons:
• Check the corresponding function button on the Control Panel to enable the button on the panel.

• Uncheck the corresponding function button on the Control Panel to disable the button on the panel.

Software Control Panel buttons: The following table lists Software Control Panel buttons and their assigned actions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Cut Next</td>
<td>✎</td>
<td>RollNow</td>
</tr>
<tr>
<td>⏳</td>
<td>Hold</td>
<td>✏</td>
<td>Second</td>
</tr>
<tr>
<td>⏯</td>
<td>Let Roll</td>
<td>⏯</td>
<td>Skip</td>
</tr>
<tr>
<td>⏩</td>
<td>Play</td>
<td>⏯</td>
<td>Ten Rel</td>
</tr>
<tr>
<td>✗</td>
<td>PrgRun</td>
<td>✎</td>
<td>Unthread</td>
</tr>
<tr>
<td>⏯</td>
<td>Protect</td>
<td>✏</td>
<td>Freeze</td>
</tr>
<tr>
<td>🟢</td>
<td>Ready</td>
<td>✏</td>
<td>+1 Sec</td>
</tr>
<tr>
<td>🟢</td>
<td>Recue</td>
<td>✏</td>
<td>-1 Sec</td>
</tr>
</tbody>
</table>

4. When finished...

• Click Save to save the Control Panel Settings

• (Optional) Click Cancel to abort the changes.

Set Playlist and Device Servers

Use the following procedure to set the playlist that will be controlled by this panel instance and their associated Device Servers.

1. On the panel, click the List Settings button to toggle on (✓) the List Settings display. The Button Settings Toggle is toggled off (☐).
2. **Select Device Servers**: From the dropdown list select (check) the Device Servers to display the playlists bound to them. Selecting the dropdown list button lists Device Servers with adjacent checkboxes and also turns the dropdown list header to list filter input field.

3. **Add / Remove Playlists** from/to the panel control.
   - Check the box button next to a playlist to add it to the list of controlled playlists.
   - Uncheck the box button next to a playlist to remove it from the list of controlled playlists.

4. Click **Save** to save the Control Panel Settings.
   - (Optional) Click **Cancel** to abort the changes.
Environment Properties

Use this procedure to configure the following environment properties: List Options, Secondary Events.

Configure List Options

1. From the main menu select **Settings > Environment**. This opens the Environment Options dialog.

2. Select **List Options** tab. Use this tab to configure how a playlist processes field information when an ID is entered or a list is loaded or validated. This is where Automatic Event Validation can be set up.

List options allows the user to select parameters that effect the behavior of the client. Settings apply to all lists that are managed through that client. Selecting OK applies the settings. Clicking Cancel, reverts any changes made to the previous settings.
3. Check to enable/ Uncheck to disable the following list parameters:

- **Auto Focus Event Centered.** During on air play back the user can jump back to the on air event if the list is scrolled down further on the playlist. It will also allow the on air event to be centered in the list with the done events above in the window.

- **Allow Secondary Event Hiding.** This allows the user to use the option of Secondary Event Hiding in the right click Playlist Options menu.

- **Confirm List Modification:** (del/cut, Insert, update, move): When enabled, when PlayList is in Revise-off mode this adds a confirmation message when performing: Delete / Cut, Paste, Add record(s), and Insert or Append a playlist.
  - The confirmation dialog displayed depends on the action taken:
    - **Apply:** confirm changes.
    - **Find Next:** This button allows an operator to find other events with the same ID and sequentially apply changes to all events with the same ID (search is performed by ID)
    - **Cancel:** cancel changes.

- Deleting/cutting one record:

- Deleting/cutting several records:

- Appending record(s):

- Appending PlayList:
Inserting PlayList:

Moving record(s):

- **Retain Segment Numbers.** When a single spot event is inserted in a playlist with a specified segment number, the segment number is removed. To disable this, select this option to retain the segment number.

- **Warn On Edit of Playing Event.** If this option is checked, editing an event that is playing results in a dialog box notifying you that the event is playing.

- **Clear Reconciliation Keys on Edit.** When this option is checked, editing events will remove the reconciliation key, if any, from those that have been edited to change the ID.

- **Clear Reconciliation Keys on Copy.** When this option is checked, copying events will remove the reconciliation key, if any, from those that have been copied.

- **Clear Reconciliation Keys on Cut.** When this option is checked, cutting events will remove the reconciliation key, if any, from those that have been cut.

- **Audible Time To Next**: Enable (check) this option to allow Playlist v5 to emit the Audible Cues through the sound card of the Playlist v5 computer. This configuration saved to /load from the Playlist v5’s .ini file.

  With this option enabled an operator can specify event type Q (Audible Time to Next) in the playlist ‘Type’ column. Audible Time to Next provides an audible countdown starting 30 seconds from a commercial break into the next live event. To minimize affect on existing functionality ‘N’ (Time to Next) is automatically set and hidden from an operator when letter ‘Q’ is entered.
**Note:** After the “Audible Time To Next” checkbox option is enabled in the List Options, it is necessary to close and re-open the list windows in the client for the feature to work. (Re-loading the lists is not necessary.)

- **Confirm event edition** (Revise): When enabled and changes are made to an event while the Playlist is in Revise mode, on exiting Revise mode this adds a confirmation message for the changes.
  - A Find next button on the *confirmation dialog allows an operator to find* other events with the same ID and sequentially apply changes to all events with the same ID (search is performed by ID)
    - Apply: confirm changes.
    - Cancel: cancel changes.

- **Notify When ID Not Found.** When checked, a dialog box will alert when an event ID entered into a playlist is not found in the database or the Valid IDs list.
- **Clear Fields When ID Not Found.** Select this option to clear the title and SOM fields when an ID is entered but not found in either the database. The duration will default to 30 seconds. This prevents events from containing the wrong SOMs and DURs when an event’s ID is edited and is not found in the database. Otherwise, when an ID is changed and does not match an ID in the database, the fields do not clear.
- **Adjust Durations When SOM Changes.** This option adjusts the duration of an event according to changes made to an event’s SOM. If the SOM is increased, the duration is decreased by an equal amount, for example. Or, if the SOM is decreased, the duration is increased by an equal amount. This ensures that the event will not play beyond its EOM time.
  
  **IMPORTANT:** For this parameter to work correctly, ensure Device Server Clocking parameter: Round DF is set to off: (Configuration Tool-> Configured Devices-> File menu in Configured Devices-> Clock-> Set Source-PC: PC Clock; Round DF: OFF.)

- **Update Events with Valid SOMs.** This option changes all events’ SOMs according to their records in the database when they are entered into a playlist. It will overwrite any events’ specified SOMs that differ from their database records.
  - Optionally, events without specified SOMs can be assigned SOMs according to their records in the database by clicking **Verify List Against DB** on the Events menu. To verify one event, or a range of events, select the event and click **Verify Event Against DB** on the Events menu.

- **Title Mismatch.** Title mismatch occurs if the value of an event’s title field does not match the event’s record in the database. If Title Mismatch option is enabled, a title mismatch file will be created anytime list is loaded or appended to Transmission List and
title mismatch occurs. A title mismatch file is a list of IDs whose titles in the playlist differ from those in the database.

On loading a list the application compares the list contents against the database. If any duration mismatches are detected, the following dialog is displayed. It suggests opening the mismatch file in the default text editor (which is associated with *.txt files).

- **Duration Mismatch.** When checked, the system will create a Duration Mismatch file listing events that have a duration that does not match the ID’s duration in the database within the specified number of frames as specified in the Max. Frame Difference field. The Max. Frame Difference field is displayed when the Duration Mismatch option is checked.

- **Verify copy against DB.** When this option is enabled (checked), an event that is copied and pasted to another location in the playlist or into another playlist will be verified for accuracy against the database. If they differ, the event metadata is updated to match the database.

Normally when a list is loaded, appended, or inserted:
- If only ‘Verify Copy Against Database’ is enabled, then only the DUR and SOM fields are updated. The Title stays as what it was when copied.
- If ‘Update events w/valid SOMs’ is enabled, then all of the event metadata is updated whether Verify Copy Against Database is enabled or not.

*Note:* The “Verify copy against DB” option and the “Use List Durations” options are mutually exclusive. (i.e. They cannot both be enabled; it’s either on or the other.)

- **Delay From Air warning:** Check to enable a delay from air warning of an event or list modification. Once enabled, specify Delay Value and Polling Value.

If the event or list modification focused in the confirmation window is at less than a configurable delay from Air (list in Play), a red warning mentions: “Action not permitted to proximity to playing event.”

This warning is dynamic. If the confirmation window is opened out of the Forbidden Area, and still opened when entering in it, then the Warning appears. This notification is note “frame accurate”. The verification of the delay from Air is done each 5 seconds (to
be sure to be warned at 30 seconds from air the delay value must be configured to 35 seconds

- **Delay Value**: Active when Delay from Air warning is selected. Specify the delay period (format: hh:mm:ss) from Air to trigger the Warning. (Minimum: 1 second, Default: 00:05:00, Maximum: 23:59:59)

- **Polling Value**: Active when Delay from Air warning is selected. Specify the polling period in seconds (format: ssss) of the frequency checking if in “Forbidden Area” when a Confirmation window is opened. (Minimum: 1 second, Default: 5, Maximum: 9999)

  - **Required**: If ‘Delay From Air warning’ is enabled, then ‘Confirm list modification’ must also be selected. If the user removes or cuts an event(s), there appears “Confirm edit” dialogue box. If any of the events is CUED (the list is playing) and Delay value is more than or equal to Remaining time of Air Event, the warning “In Forbidden Area!” is displayed.

- **Use List Titles**: This option uses the titles of events from a traffic list instead of the database when loaded into a playlist. If this option is not checked, titles listed in the database are used.

- **Use List Durations**: When this option is enabled (checked), Playlist v5 retains the durations of events as they appear in the playlist. All other event metadata is updated to match the database. When this option is disabled (unchecked), durations specified in the database are used.

  - **Note**: The “Verify copy against DB” option and the “Use List Durations” options are mutually exclusive. (i.e. They cannot both be enabled; it’s either on or the other.)

4. When finished click....

  - **Save** to saves changes. The window remains open.

    or

  - **Apply** to saves changes and close the window.

    or

  - **Cancel** to abort the operation and close the window without saving changes.

**Configure Hardware Control Panel Properties**

The Operator Control Pane is a mid-sized desktop controller that provides instant audio or video playback and control for broadcast automation, post production and other applications. This panel gives operators a choice in controlling automation environments by providing unambiguous button control in addition to conventional keyboard and mouse operations.

The Operator Control Panel (OCP) is configured through the Playlist v5 software.

- Playlist v5 supports up to two Operator Control panels and allows you to configure the functionality of control and list buttons.

- Up to 10 banks of 6 list buttons can be configured. The Bank selection buttons allows an operator to select each bank of list buttons.
List buttons are used to open a transmission list quickly during Playlist v5 operation. List buttons are arranged in banks of 6 button assignments each (Bank 1, Bank 2, Bank 3,...Bank 10). Pressing a different Bank button on the panel switches the top row of 6 LED buttons on the panel to that bank of 6 assigned List buttons.

- A button from the bank can be assigned to a single list or to several lists.
- Once assigned, when button is pressed for that bank, control is shifted to that list.
- When ADC shifts control to that list, the panel will stay in sync and also shift control to the same list.

Control buttons allow the operator to perform control actions on the currently active List or Lists.

- The labels are editable in the User Interface.
- If a button's label is blank (no spaces or other characters) the button's backlight is extinguished.

To Configure the Operator Control Panel (OCP)

Use this procedure to configure parameters for the Operator Control Panel used with Playlist v5. Once these parameters have been set, they should not need to be changed.

Please contact your Tech Support Representative for assistance before changing any of the settings.
1. From the main menu select **Settings > Environment**. This opens the Environment Options dialog.

2. Select **Hardware Control Panel**. The hardware control panel option allows the user to configure an Operator Control Panel (OCP) to be used in conjunction with the client. If no hardware control panels are configured, this will show the default configuration of one OCP with no I/O port, default actions and no list assignments.

3. From the I/O Port dropdown select the desired serial Port. The following port options are available:
   - No Port
   - COM 1
   - COM 2
   - COM 3
   - COM 4

4. **To Configure the List Group**. List groups are used to open a transmission list quickly during Playlist v5 operation.
   - In the Lists pane, click on the Modify icon (    ) for a specific numbered button (left panel) which corresponds to a physical button on the OCP top row of 6 buttons. (Notice the buttons are already in groups of six.). The List Assignment dialog appears. Use this dialog to select one, or multiple, lists to assign to an OCP list button.
     - The Device Server(s) provides information of the Lists that are available.
Note: Lists open in Playlistv5 that are hosted on a Device Server, which is subsequently removed from the configuration, are closed.

- Select which Transmission List will open when the button is pressed on the OCP. Use the move keys to select (>, >>) and deselect (<, <<) entries.
  - >: Move a single entry from Available pane to Assigned pane
  - >>: Move all entries from Available pane to Assigned pane
  - <: Move a single entry from Assigned pane back to Available pane
  - <<: Move all entries from Assigned pane back to Available pane

Note: Gang play can be implemented by selecting multiple lists on a single list button.

- When finished, click Save.

5. **To Set a Button Action for OCP Buttons 7 – 24.** Action buttons are used to carry out numerous On Air actions during Playlist v5 operation.

- In the Buttons pane, select a specific Buttons Action (e.g. Hold) that corresponds to a physical button on the OCP (buttons 7 – 24).

- Use the action assignment dropdown list to change the action assigned to a specific button or to set it to “no action”.

Note: Lists open in Playlistv5 that are hosted on a Device Server, which is subsequently removed from the configuration, are closed.

- Select which Transmission List will open when the button is pressed on the OCP. Use the move keys to select (>, >>) and deselect (<, <<) entries.
  - >: Move a single entry from Available pane to Assigned pane
  - >>: Move all entries from Available pane to Assigned pane
  - <: Move a single entry from Assigned pane back to Available pane
  - <<: Move all entries from Assigned pane back to Available pane

Note: Gang play can be implemented by selecting multiple lists on a single list button.

- When finished, click Save.

5. **To Set a Button Action for OCP Buttons 7 – 24.** Action buttons are used to carry out numerous On Air actions during Playlist v5 operation.

- In the Buttons pane, select a specific Buttons Action (e.g. Hold) that corresponds to a physical button on the OCP (buttons 7 – 24).

- Use the action assignment dropdown list to change the action assigned to a specific button or to set it to “no action”.

Note: Lists open in Playlistv5 that are hosted on a Device Server, which is subsequently removed from the configuration, are closed.

- Select which Transmission List will open when the button is pressed on the OCP. Use the move keys to select (>, >>) and deselect (<, <<) entries.
  - >: Move a single entry from Available pane to Assigned pane
  - >>: Move all entries from Available pane to Assigned pane
  - <: Move a single entry from Assigned pane back to Available pane
  - <<: Move all entries from Assigned pane back to Available pane

Note: Gang play can be implemented by selecting multiple lists on a single list button.

- When finished, click Save.
Assignable actions: The following is a description of each action that can be assigned to the action buttons on the hardware control panel:

- **No Action**: No action is performed by this button.
- **Hold**: Holds the current event’s duration, allowing the event to continue to play beyond its specified duration.
- **Air Protect**: Switches between air and protect devices.
- **Let Roll**: Rolls an event without switching a router. If the list is unthreaded, the first time threads the list and the second time plays it. Without router it works as Roll.
- **Ten Rel**: Tension releases the VTR for the next VTR event.
- **Unthread**: Unthreads lists assigned to a list button and stops on-air playout.
- **+1 Sec**: Adds one second to the duration of the playing event.
- **Gang Play**: Play/control multiple lists. Gang play is implemented by selecting multiple lists on a single list button (See step 4).
- **Roll Now**: Identical to the Roll button on the software control panel. Roll bypasses normal preroll values and plays the next event as fast as the equipment will allow. If the current event is playing normally, the Roll button skips it and plays the next event using normal preroll values unless configured to use instant preroll values. If the current event is frozen, this button will play the next event. If the current event is being held, clicking this button plays the event.
- **Prog Run**: Prepares a playlist for play by threading the devices in a playlist.
- **Ready**: Ready the media for the Play command.
- **-1 Sec**: Subtracts one second to the duration of the playing event.
- **Freeze**: Freezes the current frame of the video of a playing event.
- **Play**: Plays the playlist.
- **Recue**: Recues the playing event.
- **Skip**: Skips the playing event and proceeds to the next event.
- **Cut Next**: Deletes the event following the playing event.

*Note: Events deleted with this action are not recoverable from the clipboard.*

- **Play Second**: The Play Second action allows a secondary audio/video event to be rolled without specifying a starting offset for the event. This allows an operator to start a primary event and roll the secondary event at any time by pressing the Second button. To identify which secondary audio/video event is affected by this action, remove any data in the TOD field of the event.

  When the Second button is pressed, the next secondary audio/video event with a blank TOD is rolled. If the Second button is pressed again, the next such event, if available, rolls. The Second button will not roll any other type of secondary event and will not roll to any secondary audio/video event if its TOD field is not blank.

  Also, a secondary audio/video event rolls the next secondary audio/video event with TOD field information if the secondary audio/video event does not have a Rejoin qualifier. This allows you to run a list of secondary audio/video events.
attached to the current primary event. If the Rejoin qualifier is attached to an event, then it will not roll any other secondary audio/video events.

**Note:** Consecutive secondary audio/video events cannot be rolled with the same ID for devices that play program material. Some devices, such as still stores and audio carts, use the event ID to match to the event ID name of the device. If this is the case, the ID can be the same for consecutive secondaries.

6. When all buttons are properly configured click...
   - **Save** to saves changes. The window remains open.
   or
   - **Apply** to saves changes and close the window.
   or
   - **Cancel** to abort the operation and close the window without saving changes.

**Cabling**

The OCP uses a straight through DB9 RS-232 connection. To complete connection with Common Hardware Platform equipment ensure the cable terminates are female (i.e. one end of the cable with need a male to female adapter.)

**Pin Connections**

<table>
<thead>
<tr>
<th>Client PC</th>
<th>Pin to Pin</th>
<th>Hardware Control Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received Data</td>
<td>2 &lt;-&gt; 2</td>
<td>Transmitted Data</td>
</tr>
<tr>
<td>Transmitted Data</td>
<td>3 &lt;-&gt; 3</td>
<td>Received Data</td>
</tr>
<tr>
<td>Signal Ground</td>
<td>5 &lt;-&gt; 5</td>
<td>Signal Ground</td>
</tr>
</tbody>
</table>

**RS-232 to USB converter for the OCP panel**

The OCP panel comes standard with RS232 connections. Third-party RS232 to USB converters, such as a Digitech RS-232 to USB converter, have been used successfully with these panels. However, Imagine Communications makes no guarantees regarding compatibility or workability of any specific converter with the OCP panel.

**IMPORTANT:** For any converter, ensure the converter port in Device Manager is set to COM 2.

---

**Configure List Appearance Settings**

This subsection defines procedures for changing the list appearance for event colors and fonts, and show/hide/move list columns. The Appearance Settings dialog provides the ability to:

- Add more event color options that reflect the status of the primary event color differences for - media / no metadata, metadata / no media, metadata / media but not QC’ed, media / yesterday's metadata
- Verify other elements needed for correct on-air playout (IE Captioning Files)
- Color code primaries based on type (IE Commercial, Promo, Movie, etc)

The ability to assign colors supports operational situations where the user needs to be able to quickly ascertain the type of content that a primary event represents. This capability can be used to distinguish different types of program content (IE movie, sport, drama, news) or different types of interstitial content (IE commercial, promo, PSA, political).

The primary reason of this more granular methodology to event identification is to:

- Allow users to differentiate between paid advertisements, promotional content and political content so that, inadvertently, paid commercial content is not removed from the schedule.
- Allow the events that comprise the playlist to be more easily identified as transitions from programming to interstitial elements will be more clearly visible.

To specify Event Colors

Use the following procedure to configure event and row colors.

1. Open a playlist window (View, New, etc.).

2. From the main menu select **Settings > List Appearance**. The Appearance Settings dialog is displayed. This dialog allows a user to specify display colors for specific content in a playlist along with the appearance and position of columns.

3. Select the **Event Colors and Fonts** tab to change the event’s colors.

4. From the Event Type list pane choose an event type.
Note: Certain settings are unavailable for the following event type selections:

- **Selected**: Event Color setting is unavailable.
- **Cursor**: Event Font, Event size and Event Color settings are unavailable.
- **CursorBackground**: Event Font, Event size and event color are unavailable.

5. **Event Color**: Specify the color of the event line. When specifying an event foreground or background color, select the down arrow (▼) to specify a new color using the color palette dialog.

6. **Event Font**: specify the following parameters for the font:
   - From the dropdown list select the font style.
• Use the spin arrows to set the font size

• From the dropdown list select the font color. When specifying an event foreground or background color, select the down arrow (▼) to specify a new color using the color palette dialog.

7. When finished click **Apply**, and then **OK**.
**Default colors**

The following are typical default colors for the following event types:

```
DONE->Primary
DONE->Secondary
On AIR->Primary
On AIR->Secondary
Next ->Primary
Error / Missing media
Commercial Break
Next ->Secondary
```

**Export and Import Color Settings**

Optionally, the Event Color and Font settings specified for a playlist can be exported for later use, or if previously saved, imported for use with other playlists.

**To export settings**

1. Click the **Export…** button. The Export Colorset dialog is opened.
2. Navigate to the location were the settings will be saved.
3. Specify a file name and then click **Save**. The file is saved as a colorset (.cset) file.

**To import settings**

1. Click **Import…** button. The Import Colorset dialog is opened.
2. Navigate to the location the were color setting have been saved. The system defaults to listing colorset (.cset) files.
3. Select a colorset file to import and click **Open**. The colorset file is imported for the playlist.

**To Define Column Settings**

Use the following procedure to configure column appearance on a list (i.e. those to show or hide, and their order.

Use the following procedure to configure event and row colors.

1. Open a playlist window (View, New, etc.)
2. From the main menu select **Settings > List Appearance**. The Appearance Settings dialog is displayed. This dialog allows a user to specify display colors for specific content in a playlist along with the appearance and position of columns.
3. Select the **Column Settings** tab to specify which columns to show and hide and to change their display organization.
4. **Show/Hide Columns.** The status of available columns is indicated by icons in the Show column. Click an icon to toggle its show/hide state.
   - The column is active (✓) and will be displayed in the list. Clicking this icon will toggle the column inactive.
   - The column is inactive (●) and will not be displayed in the list. Clicking this icon will toggle the column active.

5. **Move columns:** The display of available columns can be organized by moving columns up and/or down in the list. Items are displayed on a playlist from left to right starting at the top of the list.
   - Click the up arrow button (▲) to move the column up in list.
   - Click the down arrow button (▼) to move the column down in list.

6. When finished click **Apply**, and then **OK**.
Ingest Component Configuration

About Installation and Setup

Installation, Setup, and configuration of Motion and/or Media Client systems on customer-provided computer(s) is performed by a qualified Imagine Communications’ Engineer.

Motion Configuration

Motion is a workflow engine that services the requirements to integrate staff, devices, and applications into a holistic workflow. Sometimes referred to as an enterprise bus, the product provides the integration and workflow structure for discrete modules that form part of the content management and digital supply chain.

The Motion Client can be installed on its own customer provided PC and Motion Server on its own customer provided server or they can reside on the same server box.

Client and Server Hardware Requirements

The following are recommended requirements for the Motion Client workstation and Motion Server as of the release of this document.

**Note:** If Motion UI and Motion Server are run on the same box, then the Server Requirements apply.

Motion Client

The following minimum requirements must be met for the Motion Client Workstation.

- **Hardware:**
  - Intel 2nd Generation Core™ i7-3770 @3.4 GHz Processor (or equivalent)
  - 8 GB RAM Minimum
  - (1) 250 GB SATA HDD
  - (1) Dual Gig-E Network Card
  - DirectX capable Graphic card- 256 MB RAM Minimum

- **Software:**
  - Win7 Pro/Enterprise/Ultimate edition 32/64 Bit
  - MSXML 6.0
  - Microsoft .NET Framework 4.0 with latest SP
  - Windows Media Format 9 Series Runtime Setup (wmfdist.exe)
• Windows Media Audio and Video 9 Series codecs (wmv9VCMsetup.exe)
• Internet Explorer 8 or higher
• Video Drivers compatible with MS DirectX 9.0c
• Anti-Virus- any commercially available product

Motion DB Server

The following minimum requirements must be met for the Motion Database Server.

- Hardware:
  • 2x Intel Xeon E5-2667 Processor (2.9 GHz, 6 core or better)
  • 24 GB of 1333 MHz registered RAM
  • 2x 300 GB 6Gb SAS 10K HDD
  • Dual Gig-E Network Card
  • 2x USB 2.0 USB Ports
  • DVD R/W Optical Drive

- Software:
  • Windows® 2008 R2 or newer with latest Service Pack
  • Microsoft® .NET Framework 4.0 with latest Service Pack (restart may required)
  • Microsoft® SQL Server® 2008 with latest Service Pack or SQL Server 2008 R2

Motion 3 Installation: Required component list

The Motion 3 system is comprised of a set of application components. The following components are required. They will be installed and setup by a qualified Imagine Communications’ Engineer.

- Core Service
- MediaSpy Engine
  • hasPluginMSNexio
  • hasPluginScanDirectory
- ProcessTrigger Engine
  • hasPluginPTMediaEvents
  • hasPluginPTStorageCapacity
- Content Handler Engine. (Does NOT include transfer monitor.)
  • hasPluginCHDynamicFTP01
  • hasPluginCHGetRecords
  • hasPluginCHGetRecordsTranslator_XML
  • hasPluginCHNexio
  • hasPluginCHOdbc01
  • hasPluginCHXmlTransform
  • hasPluginGWADC100NT01
  • hasPluginGWASDB01
* APILIB32.dll
* VersioAutoIngest.xslt
* VersioAutoIngestMetadataTemplate.xml

- For Workflow 1:
  - hasPluginPTMediaEvents for Process Trigger: This workflow trigger is used for File Transfer.
  - Dynamic FTP Delete File within hasPluginCHDynamicFTP01 (part of workflow) is used to delete media from Source folder.
  - hasPluginCHGetRecordsTranslator_XML (part of workflow) is used to Translate xml to DB Record.

- For Workflow 2:
  - hasPluginPTStorageCapacity for Process Trigger: This workflow trigger uses remaining capacity to detect storage level and delete content as required.
  - "ADC Needs Media" within hasPluginGWADC100NT01 (part of workflow) is used to check the playlists before deleting content.

**Customer-Specific Settings**

Once the Motion system is installed, the following customer-specific settings are required for Versio operations:

- **Watch Folder IP Address**: This is the path/folder Media Spy will be spying for new content. It is set in the Media Spy configuration.
- **Versio Storage IP Address**: This is needed for Connection Resources within workflows. It is set in Content Handler under Connection Resources and under Server DataSource Setup.
- **Automation Database IP Address**: This is needed for Connection Resources within workflows and for an ODBC connection. It is set in Content Handler under Connection Resources.
- **Motion Database IP Address**: This is needed for an ODBC connection and is set in Content Handler under Connection Resources. It is set in the ODBC Data Source Administrator (c:\windows\SysWOW64\odbcad32.exe) on the machine hosting the Content Handler application.

---

**Media Client Configuration**

The Media Client is a Windows-based workstation dedicated to media preparation tasks such as dubbing, material review as well as material timing and preparation. It is also used for Database management. As a client workstation on the automation Network, the Media Client uses Source, Record and Review devices controlled by a Device Controller.

The Media Client v4 software runs on a customer provided PC. It is connected via a network (customer or Imagine Communications-provided) that allows it to connect to its target Versio unit.
Client Hardware Requirements

The following are minimum system requirements for the Media Client workstation as of the release of this document.

- **Hardware:**
  - Processor: Pentium 4 3.0 GHz or greater
  - RAM:
    - For 32-bit OS: 1 GB RAM or higher
    - For 64-bit OS: 2 GB RAM or higher
  - HD: 80 GB Hard Drive or greater (Required: 25MB of free Hard Drive Space)
    - (For Windows 7: 16 GB available hard disk space (32-bit) or 20 GB (64-bit))
  - 2 TCP 1000BT NICs
    - Additional Intel Network Interface Cards may be required for systems connecting to external networks, or a database using TCP/IP.

- **Operating System:** Windows 7
  - If connecting to Device Sever v12, IPV6 Network Protocol is enabled on the Client v4 computer.

**IMPORTANT:** Ensure the Windows default Firewall is **DISABLED** on the Device Server, Versio, Media Client and Config Tool.

- **Network Interface Card:** GigE GB Ethernet and switch is required

To Install Media Client on a Workstation

This section describes how to install the Media Client on a client workstation using the Installation Wizard.

**If installing a new version of Media Client over an existing version:** Before installing, reboot the computer. Do not run Media Client on this station after rebooting and before installing the new version. If this is not done, the installation may not complete successfully, and may have to be restarted.

1. Run the Installation Wizard (MediaClientInstall.exe).
2. Read the Welcome dialog. When ready to continue press Next.
3. On the License dialog the Read and accept the license, and then press Next.
4. On the Setup Type dialog select the setup type for traffic AsRun and schedule formats:
   - Options are:
     - Enterprise (Default): This is the most typical selection.
     - Sony
   - When ready to continue press **Next**.
5. On the Server Name and Destination dialog specify the following:
• Installation Path: Accept the default or - if you like - press Browse to change the directory into which the application program files will be installed.
• Client Name: This is the name of the client workstation the application is being installed on.
• Server Name: This is the name of the primary Device Server the application will first connect to.
• When ready to continue press Next.

6. On the Installation Confirmation dialog, click Install. The application is installed.

7. On the Completion dialog, click Finish to complete the installation.

**Note:** The Media Client Version.ini file includes the build information: Version, AsRun, and Database. Having this information in an INI file helps Automation Support identify key information to troubleshoot issues.

## Manage the Desktop Shortcut for Media Client

The Media Client shortcut icon is used to launch the Media Client application from an icon on the desktop.

### About Shortcut Parameters

Before launching Media Client, create a shortcut and specify parameters in the shortcut target, such as the file path to the application, the client name, and the Device Server name.

**Note:** The maximum allowable Device Server name is 16 characters.

Optional parameters that can be specified include:

- the backup Device Server name.
- the maximum length of a material’s name.
- the maximum length of a material’s title.
- the platform the Device Server is running on.

**Format:** `<Path> <Client Name> <Device Server name> <Backup Device Server name> <Max ID Length> <Max Title Length> <DS Platform>`

**Examples:**

```
C:\......_ADC\1000\MCLIENT.exe MCLIENT MAIN /NT
C:\......_ADC\1000\MCLIENT.exe MCLIENT MAIN_DS BACK_DS IDLEN=32 TITLELEN=32 /NT
```

### Limitations:

- Ensure the MAIN and BACKUP Device Servers are configured identically in terms of devices and assignments. It is expected a Main/Backup configuration is to be used with a serial transfer switch to move devices from the MAIN Device Server to the BACKUP Device Server.
- Do not configure both main/backup Device Servers in the shortcut and the multiserver login at the same time (on a per client basis) as it can cause issues with prep form displays during connection/reconnection.
Configuring main/backup Device Servers in the client shortcut is not dependent on Multiserver login feature.

To Manage the shortcut on the Desktop

1. Open My Computer on desktop.
2. Open Local Disk (C:).
3. Open Media Client folder.
4. Right mouse click and hold on the Media Client .exe file and drag to the desktop.
5. Select Create Shortcut(s) here.
6. Define the shortcut properties by right clicking on the icon and selecting Properties.

Open
Run as…
Scan for Viruses…

*WinZip

Send To

Cut
Copy

Create Shortcut
Delete
Rename

Properties

7. Click the Shortcut tab. The Target: field should contain a path following this format:

[file path] [client name] [server name] [backup name] {material ID length} {material title length} {platform}

Modify the entries as required:

Note: Remember to include a “space” between the entries.

Note: In current versions of MC4.x/AC4.x we still need "IDLEN=32 TITLELEN=32 /NT" because it’s not there by default. By default Media Client still operates with short ID/TITLEs and with truncated device names.

IMPORTANT: All clients connecting to the same Database and Device Server's in a facility should be configured in the same IDLEN=32 TITLELEN=32).

- [file path]: The file path of the Media Client application is the path the shortcut follows to launch Media Client. This is defined for you when you create a shortcut.
- [client name]: Specify the name of the client, using no more than eight characters. Each client must have a unique name on the network. For example: MCLIENT1.
- The client name should be the same as the PC’s name just without the – hyphen. For example: “PC windows login = MCLIENT-1, session login for Client Application = MCLIENT1
• [server name]: Specify the name of the server to connect to when launching. For example: MAIN_DS.

• {material ID length}: Use the idlen parameter to specify the maximum number of characters (up to 32) the ID can contain. For example, Idlen=32.

• {material title length}: Use the titlelen parameter to specify the maximum number of characters (up to 32) for the material title. For example: Titlelen=32.

• {platform}: If the server you are connecting to runs Microsoft Windows NT, enter /nt or \nt.

• –v12 switches are needed only on start up for the first Device Server the client connects to. After that, the operator can use MultiServer login to connect to any Device Server.
  ▪ /v12 or -v12 is optional in shortcut for the Air Client /Media Client connecting to the Device Server v12. This is the first Device Server it connects to.

8. When finished click OK.

Required Material Content Configuration

Device Server and Media Client are configured depending on the type of material being ingest: single spot, multi-segment (single file multi-segment and multi-file multi-segment) content. This section outlines the configurations specific to the listed content types. It is provided for reference.

▪ For detailed instructions on configuring Media Client see ADC Media Client v4.2 Operations and Installation Reference.

▪ For detailed instructions on configuring Device Server see Versio v2.0 Automation Device Server v12 and ConfigManager Install and Operations Reference.

Note: Single spot and/or multi-segment are the most common types of material ingested and played out.

Versio Assumptions and Limits:

▪ Source Device is always VTR

▪ Record Device is always Nexio Stream 6 (encoder)

▪ There is no Review device.

Config Tool

While Versio device assignments are preconfigured based on the package purchased, the type of segments to be used must be specified. (For details see Versio v2.0 Automation Device Server v12 and ConfigManager Install and Operations Reference.)

1. Launch the Config Tool. (The default password is lowercase harris.)

2. Highlight a Device Server and then from the main menu select File > Configured Devices.

3. Select the NEXIO IP device in the left pane, right-click and from the popup menu select Properties. The configuration dialog is displayed for this device.

4. In the navigation pane expand a Stream 6 and then select Segments.
Ensure the following parameters are set:

**IMPORTANT: Only one set of parameters can be set.**

- **For Single Spot & Single File Multi-Segment, set:**
  - Modify Segment IDs (# of Characters): 0  (default)

- **For Multi-File Multi-Segment (0-9), set:**
  - Modify Segment IDs (# of Characters): 1
    
    Each segment is copied into a separate file on the disk. In this case each file name will have a suffix consisting of a one digit number appended to the ID (0 -9).

- **For Multi-File Multi-Segment (0-99), set:**
  - Modify Segment IDs (# of Characters): 2
    
    Each segment is copied into a separate file on the disk. In this case each file name will have a suffix consisting of a one or two digit number appended to the ID (0 -99).

5. When finished click **Save**.

**Media Client**

Set the following Media Client configuration parameters. These settings correlate with the settings on the Config Tool.

1. Launch Media Client. (The default Login is typically Admin and leave the password blank.)

2. From the **Configuration** ribbon tab select:

   - The Single Spot icon ( ). The Single Spot Configuration dialog is displayed. Use when configuring for single spot content.
• **The Multi Segment** icon ( ). The Multi-Segment Configuration dialog is displayed. Use when configuring for multi-segment (single file multi-segment or multi-file multi-segment) content.

3. Select the **Source** tab to configure Source Device(s). The source device is the device on which the media will be dubbed from and is specified on the Source tab.

Set the following parameters:

- **Server**: Select the server the source device is connected to (e.g. Versio-DS). The Server pull down will only allow you to select the Device Server logged in to when Media Client is launched.

- **List**: Select **Media List 3**. While the List pull down will allow you to select any list on the selected Device Server, doing so may cause undesirable results. Most facilities will never change this box.

- **Configuring Source Devices**: Set unneeded Device combo boxes to “None.”
  - **Device**: For Versio this is a VTR. Use the Device pull down to select the source device to use. Only devices that are unassigned or assigned to your Media List are listed in the device drop down lists.
    A device may be selected only once. Once a source device is selected, it will not be displayed in other source combo box’s dropdown list.
  - **Control Track/Time Code**: If using a VTR, select Control Track or Timecode for the Media Client to read. This parameter is only enabled when the corresponding selected source device is a VTR.
    Either of two items can be selected from this combo box: “CT” (Control Track) and “TC” (Time Code).
    When a VTR is initially selected, the default value of “Control Track/Time Code” is “TC”.

© 2014 Imagine Communications Corp.     Proprietary and Confidential   8-April-2014  | Page 84 of 113
If Timecode (TC) is selected, the timecode displayed on the source device button on the device selection panel is identical to the timecode on the tape. If Control Track (CT) is selected, the timecode display is set to 00:00:00.00. If no device is selected in a specific Device combo box, then the corresponding “Control Track/Time Code” and “Crash record” is blank.

- **Crash Record**: (Default: Disable) For Versio accept the default setting. Enabling Crash record allows the user to crash record on the source device.

  **WARNING**: This feature is typically used when satellite feeds media to the source device. It is not recommended that you enable this feature unless you are specifically using it for this reason because you may inadvertently erase media from the source device.

4. Select the **Record** tab to configure Record Device(s). The record device is the device on which the media is dubbed to and is specified on the Record tab.

4. Select the **Record** tab to configure Record Device(s). The record device is the device on which the media is dubbed to and is specified on the Record tab.

Configure the following as required:

- **Select the Record Device(s)**: For Versio select Nexio Stream 6 (encoder).
- Accept all other default settings.

5. If configuring for:

- Single Spot content, jump to Step 7.
- Multi-segment, single file multi-segment, or multi-file multi-segment content, continue with Step 6.

6. On the **Segments** tab, configure the following as required for: multi-segment, single file multi-segment, or multi-file multi-segment content.

   - Multi-Segment: If Modify Segment IDs (# of Characters): 0 is set for Nexio Stream 6 > Segments on the Config Tool, then...
- Under **Disk Files** enable (check) ‘**Copy All Segments to Single File**’. When database records are accessed and Auto Copying is done, this instructs Media Client to see all segments of a show as one clip. If “Copy All Segments To a Single File” is selected, all Multi-segment files copied to disk will be placed in a single file. If “Copy All…” is selected the “Number of…” control is disabled.
- Accept all other parameter default settings
- Single File Multi-Segment: If Modify Segment IDs (# of Characters): 1 is set for Nexio Stream 6 > Segments, on the Config Tool, then...
  - Under **Disk Files** disable (uncheck) ‘**Copy All Segments to Single File**’.
  - Under **Segment Numbering** set the ‘**Number of Characters**’ to 1. Each segment is copied into a separate file on the disk. In this case each file name will have a suffix consisting of a one digit number appended to the ID (0-9). The “Number of Characters” setting determines how many digits are used.
  - Accept all other parameter default settings
• Multi-file Multi-Segment: If Modify Segment IDs (# of Characters): 2 is set for Nexio Stream 6 > Segments on the Config Tool, then...
  ▪ Under Disk Files disable (uncheck) ‘Copy All Segments to Single File’.
  ▪ Under Segment Numbering set the ‘Number of Characters’ to 2. Each segment is copied into a separate file on the disk. In this case each file name will have a suffix consisting of a one or two digit number appended to the ID (0 - 99). The “Number of Characters” setting determines how many digits are used.
  ▪ Accept all other parameter default settings

7. When finished click **Save**.

**NEXIO Audio Track Routing with ADC Media Client**

This enhancement was introduced with Media Client v4.16 and provides the possibility to work with Audio Routing functionality for Media Client. This provides and operator with the ability:

▪ To view and change HD an SD Input audio masks of device.
▪ To view and change Tag Assignments for selected media.

**To Set Input Masks**

Media Client provides and operator with the ability to work with NEXIO Audio Routing functionality by viewing and setting input masks from a Media Client PrepForm Configuration on per-record source basis.

1. From the Configuration ribbon tab select the required Prep form: Single Spot ( ), Multi-Segment Spot ( ), or Multi Spot ( ). The Configuration dialog is displayed.
2. Select the Record Tab.
3. Select the NEXIO Stream, and then click Audio Input button. Tag Assignments form is opened.
4. Make required changes on the Tag assignments dialogs. For example purposes the Single Spot Configuration is used.
   - To change a Tag:
     Change the tag for a channel(s), and then press button Save. The form is closed.
   - To Set a Preset:
     Change desired tags, and then press “Save Preset”. The new Preset is added in the list of Presets in Preset ComboBox.

To Correct a Mask Tag

After ingest, if an incorrect mask was utilized, an operator can correct the Tag Assignments (which are stored inside the clip).
1. Ensure the proper Clip is specified in the Prep Form.
2. From the Material tabs on the Prep Form select the Additional tab.
3. Click on the “Edit Tag Assignments: button to display a form for editing metadata of the ingested clip.
4. Make any required modifications in the Tag assignments dialog.
5. Select Save. Media Client sends a new Input Mask or Tag Assignments to the driver and the driver then sends a command to the device.
Using the AsRun Services functionality with ADC Database and ASDB Database

The AsRun service uses ADC DB via Data Service to saves AsRun logs to text files. By default Material Service v5.3 uses ASDB database. Since the ADC DB is required for AsRun Services functionality only, it is necessary to deploy the ADC DB to the same machine as the ASDB database and to ensure both Databases have the same user.

1. The ADC Database is installed as part of the standard Services installation.
2. REQUIRED: Install the Services on the same DB File Server as ASDB (or install the ASDB database to the same DB File Server as the ADC DB.)

ADC Services can be installed to another machine, but during installation it is necessary to specify address of SQL server where ASDB is deployed. Since a dropdown list of available SQL servers contains only local SQL servers, during Services installation manually enter the name/IP of remote SQL server that contains ASDB. (For details see step 7 of Installing Services.)
Default settings for Services v5.3.23 and higher:

- The Material Service is configured to use ASDB database.
- The Data Service is configured with the proper settings to use ASDB database and ADC DB. See the following bullet.
- The ADCServices installer grants access to ADC DB for ASDB users “HarrisDB” and “LouthDB”.

About Reconfiguring Data Service

If it is expected to reconfigure Data Service to use a customer’s pre-existing ASDB, it is necessary to deploy the ADC DB on that same SQL Server. This can be done by reinstalling the Services to the customer’s SQL Server.

**Note:** It is recommended to save xml configuration files.
Automation Appendix

Windows 7 Settings

Microsoft Internet Information Services (IIS) is a web server application and set of feature extension modules created by Microsoft for use with Microsoft Windows. IIS 7 and higher supports HTTP, HTTPS, FTP, FTPS, SMTP and NNTP. IIS is tightly integrated with the Windows Server family of products, resulting in faster Web page serving. IIS is not turned on by default when Windows is installed.

The Manager Service Client application requires IIS 7 or higher. IIS settings must be enabled on the Server (For Versio: Windows 7 -64bit).

Recommended: Follow Microsoft standard procedures for installing IIS.

Installing and Enabling IIS on Windows 7

Typically Windows 7 comes standard with IIS6. The Manager Service Client requires IIS 7 or higher. Perform the following actions to install this higher version and to enable IIS Services.

1. Download and install the appropriate inetmgr from Microsoft:
   - If running a 64bit version of Windows 7, use inetmgr_amd64.msi

2. From the Windows 7 desktop select: Start>Control Panel>Programs and Features> Turn Windows features on or off

3. Enable (check) the following options: Internet Information Services, all Web Management Tools, and all World Wide Web Services. When finished click OK.
4. The following dialog is displayed while the system processes the changes.

**UAC Settings On Windows 7**

To ensure stable client operations when connecting Playlist v5.2 to the Device Server, disable UAC on the OS Action Center.

Use the following procedure to disable UAC on a Windows 7 system.

1. From the desktop select: Start > Control Panel > Action Center
2. Select “Change User Account Control Settings”
3. Set slide to “Never Notify”. (i.e. reduce UAC Settings to the lower level)
4. Click OK.
5. Restart the computer for the changes to take effect.
Device Server and Config Tool Installation

The Versio Automation system comes with all required software installed by an automation Field Engineer. If, for some reason, the operating system and Automation Device Server software need to be reinstalled, contact Imagine Communications Support for assistance.

Discuss any configuration changes station staff or Imagine Communications Customer Support Engineers may have made to the system during commissioning.

**Note:** It is essential to back up Device Server software and configuration files (ADC1000NT.INI, LISTCONF.INI, HANDLES.INI) to another location before attempting to reinstall the operating system. These files are usually located in the “C:\Server” folder on the Device Controller.

To reinstall the Device Server application (if required)

This section describes how to install the Device Server on a Device Controller computer using the Installation Wizard.

**If installing a new version of Device Server over an existing version:** Before installing, reboot the computer. Do not run Device Server on this computer after rebooting and before installing the new version. If this is not done, the installation may not complete successfully, and may have to be restarted.

**Note:** If needed, the installers for Versio Automation components are located on sub folders under C:\Install\ADC.

1. Run the Installation Wizard (ServerInstall.exe) on a Device Controller computer.
2. Read the Welcome dialog. When ready to continue press **Next**.
3. On the License dialog read and accept the license, and then press **Next**.
4. On the Server Name and Destination dialog specify the following:
   - **Installation Path:** Accept the default or - if you like - press Browse to change the directory into which the application program files will be installed.
   - **Server Name:** This is the name of the Device Server (e.g. Versio-DS).
   - When finished press **Next**.

   **IMPORTANT Versio Note:** If the command line Device Server name is changed, the Versio Magellan Software Manager must also be changed, so that, if the Device Server starts automatically after a re-boot, it starts with the intended name.

5. On the Installation Confirmation dialog, click **Install**. The application is installed.
6. On the Completion dialog, click **Finish** to complete the installation.

Confirm the Application Icon Command Line

Before running the Device Server application, you may wish to check that the command line for the application is written correctly.
1. Right-click on the Automation icon on the Device Server’s desktop, and then select “Properties”.

2. In the window that opens, select the “Shortcut” tab.

3. In the target field, the command line should read “C:\Server\adc1000nt.exe Versio-DS”. The “Versio-DS” in the command line is the application name for this instance of the Device Server application.

4. Each instance of the Device Server application on the LAN must have a unique application name. The names used are optional. You may rename your Device Server application name to suit your needs.

   **Note:** If you change the application name for your Device Server, the command lines for all client applications must be changed accordingly. If not, the client applications will not be able to log into the Device Server.

   **CAUTION:** The path name should not have spaces; otherwise quotation marks are automatically placed around the path. If quotation marks appear around the path, all command line syntax must be placed outside of the quotation marks.

   For example,
   - Correct: C:\VersioServer\adc1000nt.exe Versio-DS
   - Correct: “C:\Versio Server\adc1000nt.exe” Versio-DS
   - Incorrect: “C:\Versio Server\adc1000nt.exe Versio-DS”
   - Incorrect: C:\Versio Server\adc1000nt.exe Versio-DS

   **IMPORTANT:** While up to 16 characters are allowed, only the first 10 characters are observed.

5. When finished, click **OK**.

**BuildInformation.ini**

Device Server v12.19 and higher includes a BuildInformation.ini file in the Device Server build which contains the build information (Version, Build name, etc.). This ini file is created in the same directory as executable file 1000 DS (ADC1000NT.exe).

Example of BuildInformation.ini file:

```
[General]
ProductName=ADCNT SERVER
CustomerName=ENGINEERING
VersionBuild=12.19.26.1M
BuildDate=October 15, 2012
ConnectionName=Versio-DS
```
To Install the Config Tool application (if required)

This section describes how to install the Configuration Manager Tool on a Client Workstation computer using the Installation Wizard.

If installing a new version of Config Tool over an existing version: Before installing, reboot the computer. Do not run Config Tool on this computer after rebooting and before installing the new version. Failure to do this may result in an unsuccessful installation, and require you restart the process.

1. Run the Installation Wizard (ConfigToolInstall.exe) on a Client Workstation.
2. Read the Welcome dialog. When ready to continue press Next.
3. On the License dialog read and accept the license, and then press Next.
4. On the Server Name and Destination dialog specify the following:
   - Installation Path: Accept the default or - if you like - press Browse to change the directory into which the application program files will be installed.
   - Client Name: This is the name of the client workstation on which the Config Tool is being installed.
   - Config Tool Password: Specify a password for the Config Tool (Default is Admin).
   - Confirm Password: Re-enter the password that was just specified.
   - When finished press Next.
5. On the Installation Confirmation dialog, click Install. The application is installed.
6. On the Completion dialog, click Finish to complete the installation.

Rename the Application Icon (Optional)

Before running the automation Config Tool application, you may wish to rename the icon.

1. Right-click on the Config Tool icon on the client workstation desktop, and then select “Rename”. The icon name field is highlighted.
2. Enter a new name for the icon then click off the name.

Install ADC Services

ADC Services’ Setup.exe includes most prerequisites and files for a completely self-contained installation.

1. Run the ADC Services installer (ADCServicesSetup_x.x.x.x.exe) provided for the services.
   
   Note: If needed, the installers for Versio Automation components are located on sub folders under C:\Install\ADC.

2. Click Install to install any missing prerequisite items.
3. On the Welcome Screen click **Next**.

4. Destination folder. Accept the default location for the ADC Services. When finished click **Next**.

5. On the Setup Type screen select to install a Complete or Custom Setup. When finished click **Next**.

6. On the Database Server window specify the database installation location and the method of Authentication used for the ADC Database. When finished click **Next** to continue.

7. On the Ready to Install Program window select **Install**.

8. To complete the installation click **Finish**.

---

### Manually Start the Services from Windows

On installation, while ADC Services are set to Automatic Startup Type mode, they are stopped and must be manually started. There are two procedures that can be used to start the services: Admin Tools > Services or form the Task Manager.

**IMPORTANT**: The ADC Manager Service controls the start operation of all other ADC Services. When this Service is running it automatically starts all other Services.

#### From the Admin Tools > Services

1. Navigate to Services: Start>Control Panel>AdminTools>Services (or alternatively start >> type services.msc to access services). If not already done, list the files in alphabetic order to ensure the ADC Service files are listed first/at the top.

2. Select the ADC Manager Service, and then in the left pane select “**Start** the service”.

![Image of Services window](image-url)
3. Wait for the Manager Service to start the other Services. This may take several minutes. (To ensure all starts register correctly, refresh the view by selecting Action>Refresh.) (Optionally, repeat for Step 2 for each remaining ADC Service.)

From the Task Manager

1. Right-click on the Desktop tray and from the popup select Start Task Manager.

2. Select the Services tab. If not already done, list the files in alphabetic order to ensure the ADC Service files are listed first.

3. Right-click on the ADC Manager Service and from the popup select Start Service.

4. Wait for the Manager Service to start the other Services. This may take several minutes. (Optionally, repeat for Step 2 for each remaining ADC Service.)

Stop/Start ADC Services from the Services Configuration Manager

If required, ADC Services can be stopped or started from the Services Configuration Manager.
To Stop ADC Services

Use this procedure to stop ADC Services from the Services Configuration Manager.

1. Launch the Manager Service Client
2. Click on the name of a Service that is in a Working State. This expands to display the available options.
   
   **Note:** Click on the Service name again to collapse the options display.

3. Click the Stop button. The service’s state changes to Stopped. This may take a minute.
   
   (Optionally, from the menu bar select File > Stop.)

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Host Name</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC Material Service</td>
<td>MaterialService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Data Service</td>
<td>DataService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Timecode Service</td>
<td>TimecodeService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC Error Reporting Service</td>
<td>ErrorReportingService</td>
<td>LOCALHOST</td>
<td>Working</td>
</tr>
<tr>
<td>ADC AsRun Service</td>
<td>AsRunService</td>
<td>LOCALHOST</td>
<td>Stopped</td>
</tr>
<tr>
<td>ADC Device Service</td>
<td>DeviceService</td>
<td>LOCALHOST</td>
<td>Stopped</td>
</tr>
<tr>
<td>ADC List Service</td>
<td>ListService</td>
<td>LOCALHOST</td>
<td>Stopped</td>
</tr>
</tbody>
</table>

To Globally Stop all Services

From the menu bar select File > Stop all. This option stops all working services. This action may take several minutes to complete.

To Start ADC Services

Use this procedure to start ADC Services from the Services Configuration Manager.

1. Launch the Manager Service Client
2. Click on the name of a Service that is in a Stopped State. This expands to display the available options.
   
   **Note:** Click on the Service name again to collapse the options display.
3. Click the Start button. The service’s state changes to Working. This may take a minute. (Optionally, from the menu bar select File > Start.)

To Globally Start all Services

With all services stopped, from the menu bar select File > Start all. This option starts all stopped services. This action may take several minutes to complete.

To Globally Restart all Services

From the menu bar select File > Restart all. This option restarts all services. This action may take several minutes to complete.

To Upgrade Services

This assumes a previous version of the services has been installed and configured.
1. Run the newer ADC Services installer (ADCServicesSetup_x.x.x.x.exe) provided for the services.
2. The system prompts to upgrade. Click OK.
3. The system prompts that a restart is required. Click OK.
4. The system prompts to Terminate the Server. Click OK.
5. The system is automatically Restarted.

Configure the Device Server Name

Always start the Versio configuration process with the Magellan Software Manager. Before making any configuration changes in the Automation Device Server, Services, or Iconstation Monitor Config tool, configure the Device Server name in the Magellan Software Manager, which is accessible from a remote computer with network access to the Versio system.

Pushes from the Magellan Software Manager are to local systems on the Versio box only.

Example: Automation Services can reside locally on the Versio box or on another computer.

- If they reside locally – and the default services names are used- changes to the Device Name are pushed to the Automation Services.

Example: Automation Services reside on another computer or have been renamed.

In the following cases the operator must then manually confirm the Device Server names match across the Automation Device Server, Services, Iconstation Monitor Config tool, and Magellan Software Manager.

- If they reside on another computer, then the changes are not pushed to them.
- If the Services have already been configured to have a different name, then the changes are not pushed to them.
**Automation Setup**

1. Open the Versio Console:
   - From the Versio desktop click the Versio Console icon (\[Image\]).
   - Or
   - Open a browser, like Internet Explorer, from a system with network access to the Versio system. In the address bar, enter the IP address of the Versio system. The Versio Console opens in the browser.

2. Click the Edit Software Settings option. Magellan Software Manager opens.

3. In the Settings Plug-ins section of the Manage Settings screen, click the **Edit Settings** button on the Versio plug-in line. The Versio settings display on a new screen.

4. Switch to the General tab to ensure:
   - "Start Local ADC Server" is checked. (Default)
   - Automation Device Server Name: Ensure the name specified in the Automation Device Server Name matches the name specified for the Device Server. (Default: Versio-DS)
5. Click Save Changes.
6. In the comment dialog enter a description of the change, then click Save.
7. Push the configuration change.
8. On the warning dialog check to enable overwrite, then click Push.
9. On the confirmation dialog click Continue.
   
   **Note:** This action will stop playout and restart the Versio system.

10. This updates Versio parameters for automatic start.
Appendix: Automation Control of On-Board Devices

Introduction

There are three devices on-board the Versio box: a NEXIO, an IconStation XML, and a Versio MCS. Since TCP/IP communication are use for these devices, there are no cabling requirements for Automation. The following information is provided as operational background for using these devices with Automation.

Note: Configuration of the device drivers is done via the Config Manager Tool. For configuration details see Versio_v2.0_Automation_Device_Server_v12_and ConfigManager_Install_and_Ops_Ref.

NEXIO Driver

Versio automation supports the NEXIO Video Disk - API/IP Driver. The automation system supports up to 8 ports per NEXIO native driver and can support numerous NEXIO Native drivers.

Audio Track Router Control

The NEXIO IP device driver can control the NEXIO Audio Track Router. The NEXIO AMP Track Router supports re-mapping audio tracks on playout and recording through use of an Output Audio Mask to identify which tracks should play on which audio channels and Input Mask to identify which input Audio should place on which audio track. These masks are used to set the output port configuration. Primary, secondary, and tertiary tracks may be specified for cases where a backup track should be played if the preferred track (e.g. language) is not present.

The Audio Track Router provides for audio track manipulation upon the NEXIO AMP™. Support for Audio Track Routing control with the NEXIO Native IP Driver is implemented with the following ADC functions:

- Playout
- Up to 255 defined track Tags. These Tags can be applied to either Input or Output Masks within the NEXIO API
- Audio Tags with either SD or HD
- API commands for SD masks and HD masks
Definition of parameters:

- Audio Mask is a parameter which defines which audio track of clip will playout on which audio channel (playout case) or which input audio stream will be placed on which clip track (recording case).
- In general, Tags are numbers that uniquely define the audio track of each clip. Each tag can have description to be more user-friendly. Exactly description used to configure audio routing by operator. Couples “Tag-Description” are common parameters of the entire NEXIO server.

Configuration of Audio Routing

Configuration of the audio routing is carried out at the ADC List level through the List Properties configuration form. Configured options of audio routing are applied to all disk drivers which are assigned to this list. If a driver (of a Video Disk) does not support audio routing (currently audio routing is supported only for NEXIO driver), then audio routing settings does not affect on the driver. Basic operations on audio routing configuration performed by ADC List include:

- Exchange of data on audio masks and audio tags with the List Options configuration.
- Storing information about the current settings of audio routing during Device Server is running, saving the settings in the INI file when the Server is shut down, loading the settings from the INI file when the Server starts.
- Transmission of audio routing settings to the driver, requesting the settings for the drivers.

Providing Audio Routing functionality by a Disk driver

To support audio routing the driver has to:

- Provide the ADC List the audio tags data
- Handle audio masks settings information from the ADC List

For Audio Masks configuration see:

Versio_v2.0_Automation_Device_Server_v12_and_ConfigManager_Install_and_Ops_Ref, section Configuring Playlists > Configuring Transmission Lists > To configure Transmission List Options > Step 11: Audio Routing (NEXIO Only)

Operation Notes

The following operation notes are relevant to Versio’s on-board NEXIO device.

Important NEXIO Bitrate Information

Starting with NEXIO software release 6.0 there are two ways to set/get recording bitrate:

- Set Record Parameters command. This is the conventional way to set channel record parameters (including bit rate). Video bit rate values greater than 50 Mbps make use of the progressive slope algorithm. However because the progressive slope reduce the granularity
of the larger bit rates stored to multiples of 5 or 10, a new Set Extended Record Parameters command was added.

- Set Extended Record Parameters command. Available with the NEXIO 6.0 software release, this command sets record parameters for a channel including the exact bit rate set for recording over 50 Mbps. The video bit rate parameter returns two bytes of data instead of the one byte provided with the previous command, which requires the progressive slope algorithm for bit rates greater than 50. This command provides a better granularity of data in those cases.

Set Extended Record Parameters command is implemented, but to maintain compatibility with previous NEXIO software releases Set Record Parameters is still available. NNAPI driver automatically determines LLM version (NEXIO software release 6.0 begins with 607.97.232 LLM version) and works according to this version.

Therefore, for different versions of the LLM driver behavior will be different:

- LLM version is earlier than 607.97.232. In this cases bit rates over 50 Mbps must be multiple of 5 and bit rate over 100 Mbps must be multiple of 10. If an incorrect value will be entered in configuration form, it will round down to the nearest correct value (e.g. 54 -> 50, 89->85, 128 ->120). Configuration form will display new value, after driver retrieves the correct value from the device.

- LLM version is later than 607.97.232. In this case, there is no rounding, bit rate value is sent as is.

**Important note for both cases:** If bit rate is set to wrong value (see Codec_Rate_Master_HD+SD2012-03-06_NoExperimental.xlsx), then there will not be any warning. The NEXIO server will allow the driver to set up a channel to record using parameters which may be invalid for the specific channel.

### NEXIO API Play Advance Command

With ADC v12.19 and higher the NEXIO API driver is modified to use C0.04 <play/advance> command to replace both C0.02 <advance> and 20.01 <play> commands.

The list logic of ADC is designed to be in absolute control of event timing. NEXIO Native (see SonyVR/Odetics protocol) was designed for the server to be responsible for frame-accurate advance from one ID to the next and limit the controller’s responsibility to monitoring the playback state and stacking subsequent IDs once the server had advanced.

- The C0.02 <advance> command was meant for use as an 'abnormal' advance; intended for operator manual or an unexpected advance where it would be impractical to use the protocol command to reset PST-OUT point for the server to internally advance.

- Whereas the C0.04 <play/advance> command implements a logic identical to VDCP 10.01 - ID will play until the duration declared and stop. Advance will never automatically occur, automation must command the advance synchronously.

- Since C0.04 is literally a duplicate of 10.01, it can (and should) also be used as the initial play command instead of 20.01. 20.01 will honor the auto-mode (40.40/40.41) state while C0.04 will always play only the ID in PST and never advance to the next stacked ID/head.
Basic Operation Scenarios

Scenario 1
1. Launch Device Server and Config Tool.
2. Configure NEXIO IP driver and Assign it to some list. In the Config Tool open List Properties window.
3. Go to Audio Routing Tab (Last Tab).
4. All parameters are available for editing.

Scenario 2
1. Launch Device Server and Config Tool.
2. Configure NEXIO IP driver and assign it to some list.
3. Open Air Client. Open List to which is assigned NEXIO IP driver.
4. Put some clips with few Audio Tracks to the List.
5. In Config Tool open List Properties window and Go to Audio Routing Tab.
6. Change Primary, Secondary and tertiary output mask. (e.g. Use “LXF Track 1” tag for the first track, “LXF Track 2” tag for the second track, etc.)
7. Start List. The sound from the audio channels appropriates audio masks. If some track is not found on the Primary mask, it should be taken from the secondary or tertiary mask.

Scenario 3
1. Launch Device Server and Config Tool.
2. Configure NEXIO IP driver and assign play and record ports to Media list.
3. In Config Tool open List Properties window and Go to Audio Routing Tab.
4. Edit Primary output and input masks (masks should be different).
5. Open Media Client and configure choosing ports for the auto copy.
6. Do auto copy.
7. Tracks in recorded clip appropriate the given Input mask.

IconStation XML Still Store Driver

The IconStation XML driver is a Still Store device driver for the IconStation based on the IconStation XML protocol that is onboard the Versio box. In addition to supporting more of the device’s available feature set, this IconStation_XML driver supports new event types, such as: Secondary Audio/Video Events, Secondary Data Events, and Secondary Data With Data Events.
**Note:** While in Playlist v5, when a secondary event is inserted into a list, a text editor dialog box opens that prompts for the data to send to a device. The data command entered is split between part in the Title field and the rest in the Data field. A comma at the end of the Title field or a leading comma in the Data field is required.

For details on configuring Secondary Data With Data Events see *Playlist Operations and Installation Reference*, section Insert Secondary Events > Configuring an Editable Secondary Event > To Configure a Data Event with Data.

---

**Operation Notes**

The following is list of the events which IconStation/XML driver currently supports:

**Secondary Audio/Video Events:**

- **LoadFire**: `<Layout Name>,<Salvo Name>,<Layer Number>`
  - Step THREAD: Load Layout and then Setup all Items commands
  - Step PLAY: Fire Salvo (in beginning or several frames earlier)
  - In beginning of 'POSTROLL' step: Kill All Items

- **ShowAll**: `<Layout Name>,<Layer Number> [,<Action Type>,<Duration>]`
  - Step THREAD: Load Layout and then Setup all Items commands
  - Step PLAY: Show All Items (in beginning or several frames earlier)
  - In beginning of 'POSTROLL' step: Hide All Items and then Kill All Items

**Secondary Data Events:**

- **LoadLayout**: `<Layout Name>,<Layer Number>`
- **SetupAll**: `<Layer Number>`
- **ShowAll**: `<Layer Number> [,<Action Type>,<Duration>]`
- **HideAll**: `<Layer Number> [,<Action Type>,<Duration>]`
- **KillAllItems**: `<Layer Number>`
- **FireSalvo**: `<Salvo Name>,<Layer Number>`

**Note:** To use SetupAll, ShowAll, HideAll, KillAllItems, FireSalvo commands it is necessary at first to execute LoadLayout command.

*Changes with IconStation.v.2.4_XMLAutomationProtocolManual_RevA_20120808*
A change to the Versio (IconStation) XML protocol required a corresponding change in the ADC driver. This change is required due to an architectural difference between the AltitudeExpress implementation and the MA410 (plus GPU) implementation of transitions.

Now the user can specify 2 additional parameters for Setup All Items and Setup Item commands in Sec Data Event in Air Client:

```
SetupAll:<Layer Number>,<Action Type>,<Duration>
SetupItem:<Item Name>,<Layer Number>,<Action Type>,<Duration>
```

**Secondary Data With Data Events:**

```
UpdateText:<Layout Name>,<Item Name>,<Data Name>,<Text>[,<Data Name>,<Text>,...]
```

- Can use 'Secondary Data With Data Events' as 'UpdateText' command has too many parameters.
- Updating of text is performed through 'Set Item' command. The title table and roll content are NOT updatable via the ‘set item’ command, even if the documentation implies it.

*<Layout Name>* - name of the Layout. This Layout should exist on IconStation device.

*<Salvo Name>* - name of the Salvo. This Salvo should exist on selected Layout.

*<Layer Number>* - the value in range 1..5.

*<ActionType>* – tag specifies the type of transition. The options are listed below.

*<Duration>* – tag sets the length of the transition in frames.

*<Item Name>* - name of the Item. This Item should exist on IconStation device.

*<Data Name>* - the data name depends on the item type. The options are listed below.
• Crawls: To update the text for a crawl item enter: **Field1** (or enter the data tag entered in the Content Editor).

• Rolls Not supported: To update the text for a roll item enter: **1-1**.

• Title Table Not supported: To update the text in a title table item, see the following examples.
  ▪ To update the text in the first column enter **1-1**.
  ▪ To update the text in the second column enter: **1-2**.
  ▪ To update the text in the third column enter: **1-3**.

• Titles: To update the text in a title table item, see the following examples.
  ▪ To update the text on the first line of your title item enter: **Field1**.
  ▪ To update the text on the second line of your title item enter: **Field2**.
  ▪ To update the text on the third line of your title item enter: **Field3**.

<Text> - contains the new content for the data.

**Salvos**

ADC v12.19 added enhanced functionality for the XML Driver for IconStation functionality that will achieve 100% deterministic on-screen timing of graphics elements.

**Required Salvos**

As part of this workflow the operator will generate salvos in a layout with a standardized naming scheme. Generally they will need to create 3 salvos with the following functions:

▪ Setup Salvo: This salvo prepares all graphical elements for display on the next frame (generally by using the setup items or setup all items functions within the salvo itself).

▪ Show Salvo: This salvo puts the graphics elements on-air generally using the show item or show all items functions.

▪ Kill Salvo: This salvo removes the graphics elements from on-air generally using the kill item or kill all items functions.

**Device Server Configuration**

For Device Server Configuration parameters specific to this function see: Versio_v2.0_Automation_Device_Server_v12_and_ConfigManager_Install_and_Ops_Ref, section Configuring Devices using Configuration Manager > Still Store Device Configuration > Step 6: Layout tab.

**Ability to create new A/V events**

The customer has to create 3 Salvos with names: SalvoPrefix-SETUP, SalvoPrefix-SHOW. SalvoPrefix-DONE for given Layout to create the new Macro.

The list of the events, that IconStation_XML driver supports, was extended by new Secondary Audio/Video Event (The Title field):

ProgSalvo:<Layout Name>,<SalvoPrefix>,<Layer Number>
Where:

<Salvo Prefix> - name of a prefix in a salvo.

- Postfixes of salvo names (SETUP, SHOW, DONE) are strictly defined and can't be specified otherwise.

<table>
<thead>
<tr>
<th>Salvo Prefix</th>
<th>GPI</th>
<th>PVW</th>
<th>Hotkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salvo1-SETUP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Salvo1-SHOW</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Salvo1-DONE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The three Salvos are executed on the different steps of the sAV event:

- Step THREAD: Fire Salvo (<SalvoPrefix>-SETUP)
- Step PLAY: Fire Salvo (<Salvo Prefix>-SHOW)
- In beginning of 'POSTROLL' step: Fire Salvo (<Salvo Prefix>-DONE)

**New Secondary Data Events:**

SetupItem:<Item Name>,<Layer Number>
ShowItem:<Item Name>,<Layer Number>[,<Action Type>,<Duration>]
HideItem:<Item Name>,<Layer Number>[,<Action Type>,<Duration>]
KillItem:<Item Name>,<Layer Number>

**Using Salvos in a Playlist**

1. Salvos are created in the IconStation. For details on creating Salvos see the *IconStation User Guide*.

2. For Automation to use a salvo, the salvo name is entered in the title field of an event line in the playlist. The salvos are specified as a parameter in the ADC IconStation XML driver event (LoadFire, ShowAll, LoadLayout etc.).

3. The IconStation XML is assigned as a device for that event.

4. The salvo can be triggered at playout if that is the purpose of the ICONX event type chosen.

---

**Versio MCS Driver**

The MCS sub-device driver for NGC (Versio) emulates a master control switcher object by extending the functionality of the IconStation XML driver interface to include master control switching capabilities including, but not limited to...

- Source selection / switching: The initial release supports Nexio 1, Nexio 2, and Live Input as the supported sources. ADC is able to switch between these “independent” sources.
- Simple Transitions (Fade, Mix, Fade/Cut, Cut/Fade, Cut only): ADC controls switching between internal NEXIO Server channels as well as external sources.
- Keying/Branding is currently supported with v12.18 or higher via the XML IconStation driver.
Multiple Language Setup Appendix

Introduction

This section describes how to setup your systems to use multiple languages with Versio. If you find that odd characters are replacing your graphics layout text, your system is not configured correctly to use Unicode characters. An indication that Unicode fonts are used in your layouts is if you see questions marks “???” displayed in the IconStation application instead of your characters. The steps in this note explain how to configure your Versio Creation Station system, Versio system, and remote systems for multiple languages.

Setup Your Systems for Multiple Languages

Use the Region and Language dialog to configure your systems for multiple languages.

Versio, Creation Station, and Remote Systems

You must perform the following steps on the Versio system, the Creation Station system, and any remote system used to update text with the Versio Console.

1. From the Windows Start menu, open the Control Panel.
2. In the Control Panel, click the “Clock, Language, and Region” > “Region and Language” option. The Region and Language dialog opens.
3. On the Administrative tab, click the Change System Locale button to select a language for your non-Unicode programs.
4. In the Region and Language Settings dialog, select the language from the drop-down list and click OK. The Change System Locale dialog opens for you to confirm the change.
5. Click the Restart Now button to restart your system.

Configure INI Files on Versio and Creation Station Systems

To support languages typed right-to-left you will need to update the inscribe.ini file on the Versio system and on the Creation Station system.
1. Navigate to C:\Program Files\IconStation.
2. Open the inscribe.ini file.
3. Enter the following line under the [Configuration] heading: GlyphProcessing=1
4. Save the file.